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1 Welcome to the Clay Tablet Translation Connector for Sitecore 1.1 The Translation Lifecycle

1 Welcome to the Clay Tablet Translation Connector for Sitecore

Welcome to the Clay Tablet Translation Connector for Sitecore (Connector). The Connector enables you to
automate sending and retrieving content from your Sitecore CMS, which dramatically reduces the effort
required to create, maintain, and publish Web content in multiple languages.

1.1 The Translation Lifecycle
The translation lifecycle is the broad process of selecting content, sending it out for translation, and then
receiving the translated content back from translation.

This set of steps usually fits inside a larger, more general process called the content lifecycle, which is the
process of creating, reviewing, editing, approving, and publishing content.

When you consider the translation lifecycle and the content lifecycle together, you have the global content
value chain, which is the strategy for managing multilingual content.

The content lifecycle and the translation lifecycle impact are impacted by the workflow steps you implement in
Sitecore to manage multilingual content.

Remember that localizing content is a subset of steps in the broader content lifecycle. This willimprove your
focus on key localization considerations, improve processes, and keep all content stakeholders included, and
together, this results in better content management.

1.2 How the Connector Helps You Manage Your Translation Lifecycle

The Clay Tablet Translation Connector for Sitecore (Connector) is a plug-in module for Sitecore. It provides a
range of features and user interface enhancements in Sitecore that enable you to select, send, monitor, and
retrieve content for translation into any language Sitecore supports.

These features automate the process, which dramatically reduces the effort and time required for the export
and re-importation of content that needs to be localized. This is very helpful when translating large volumes of
content or ensuring that translated content is quickly re-imported to meet deadlines.

When you use the Connector, you manage your translation lifecycle entirely from within the Sitecore CMS:

1. The Connector exports your content from Sitecore in either XML or HTML format and delivers these content
files to the central, hosted Clay Tablet Platform.

2. The Clay Tablet Platform delivers your content to your translation providers, based on routing rules that
your company chooses and Clay Tablet Technologies implements.

3. When the translated content is ready, the Clay Tablet Platform retrieves it from your translators and delivers
it to the Connector.

4. The Connector automatically re-imports the content into the correct location in Sitecore.

You can then review, revise, reject, or publish the translated content as needed.

Clay Tablet Translation Connector for Sitecore User Guide Page 5

Version 3.6.2 February 25, 2014



1 Welcome to the Clay Tablet Translation Connector for Sitecore 1.3 Using this Guide

Note: Neither the Connector nor the Clay Tablet Platform performs any translation. Similarly, Clay Tablet
Technologies does not provide any translation services. Your company chooses the translation provider that
performs the translation.

1.3 Using this Guide

Purpose of this guide

This guide describes how to use the Clay Tablet Translation Connector for Sitecore (Connector) to manage your
translation lifecycle. It describes how to send Sitecore items for translation and receive them back from
translation.

Who should use this guide

This guide is intended for content editors, project, marketing, localization or translation managers, or others
who are responsible for creating, editing, or approving content for translation that resides in your Sitecore CMS.
This guide is also useful for translation providers who receive content from your Sitecore CMS, because it
describes your company's translation management process.

What your company setup should be

This document assumes that:

= Your company already has a functioning instance of Sitecore.

= The Clay Tablet Translation Connector for Sitecore (Connector) has been implemented, configured, and
tested on your Sitecore CMS.

m Clay Tablet Technologies has set up the Clay Tablet Platform to send content to your translation providers.

What you should already know
This document assumes that:

® You are familiar with the Connector's configuration for your Sitecore CMS, and the reasons for choosing
certain configuration options. This is important because your company's configuration determines which
features are available.

®m You have a strong working knowledge of the Sitecore Content Editor.

® You are familiar with the basic concepts of the Sitecore Workflow features. This is crucial, because workflow is
a core concept required to use the Connector.

® You are familiar with your company's translation process and requirements.
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1 Welcome to the Clay Tablet Translation Connector for Sitecore 1.3 Using this Guide

® You have valid user credentials to log into Sitecore.
= You have the required permissions to access the Connector functionality described in this guide.

Note: Not all the features described in this guide may be available. Feature availability depends on both your
company's Connector setup and the roles to which you are assigned. If you cannot access functionality that
you need, contact your company's Sitecore administrator.

How this guide is organized

This guide contains the following chapters:

Chapter Description

"Welcome to the Clay Tablet A brief description of the Clay Tablet for Sitecore solution and how it fits

Translation Connector for into the translation lifecycle. It also includes information about this guide

Sitecore" on page 5 and Clay Tablet Technologies Support contact information.

"Getting Started with the How to get started and an overview of the Clay Tablet Translation

Clay Tablet Translation Connector for Sitecore interface and key features.

Connector for Sitecore" on

page9

"Creating Content for How to create, adapt, and filter Sitecore content so that you can send it

Translation" on page 18 out for translation using the Clay Tablet Translation Connector for Sitecore.

"Sending Content to How to use the Clay Tablet Translation Connector for Sitecore to send out

Translation" on page 33 content for translation.

"Monitoring Translation How to monitor the translation status of content that you sent out for

Status" on page 66 translation.

"Reviewing Translated How to review and publish translated content after it automatically returns

Content" on page 76 from the translation provider to the Sitecore CMS.

"Post-Translation Features" How to perform post-translation tasks, including synchronizing

on page 78 translations, requesting a translation correction, updating a remote TM
(translation memory) server, and clearing the translation backup data.

How to find out more about Clay Tablet Translation Connector for Sitecore

For information on installing and configuring the Clay Tablet Translation Connector for Sitecore, read the Clay
Tablet Translation Connector for Sitecore Installation and Configuration Guide.
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1 Welcome to the Clay Tablet Translation Connector for Sitecore 1.4 How to Contact Clay Tablet Support

Documentation conventions

This guide uses the following conventions:

Convention | Description

Bold Highlights screen elements such as buttons, menu items, and fields.

Courier Highlights input, file names, and paths.

Italics Highlights terms to emphasize, variables, or document titles.

> Indicates a menu choice. For example, "Select Sitecore Desktop > All Applications > CT3
Translation > Translation Filter."

1.4 How to Contact Clay Tablet Support

Email @: support@clay-tablet.com
Telephone: +1-416-363-0888 option "3"
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore 2.1 Key Features

2 Getting Started with the Clay Tablet Translation Connector for Sitecore

The Connector supports the Mozilla Firefox and Google Chrome web browsers.

To access the Connector, log into Sitecore.

2.1 Key Features

The Clay Tablet Translation Connector for Sitecore (the Connector) has the following key features:
m "Multiple Ways of Sending Content for Translation" on page 9

m "Optimizing Translation Costs" on page 9

m "Selecting a Translation Provider" on page 10

2.1.1 Multiple Ways of Sending Content for Translation

= There are the following multiple ways to send content items out for translation:

# Send a single content item for translation from the Sitecore Content Editor. For details, see "Submitting a
Content Item for Translation using the Content Editor" on page 34.

# Send a single content item for translation from the Sitecore Page Editor. For details, see "Submitting a
Content Item for Translation using the Content Editor" on page 34"Submitting Content for Translation
from the Page Editor" on page 39.

# Send multiple content items using the Bulk Translation wizard. You can filter to exclude content, and
send out requests for translations of one target language at a time. For details, see "Sending Multiple
Content Items for Translation" on page 44.

= Depending on your company's Connector configuration, you may be able to send content out for translation
either immediately or via a queue.

@ Send content immediately to the translation provider.

# Send content via the Translation Queue, which enables you to group items together by project and
priority, target language, and require additional approval. For details, see "Submitting Content for
Translation from the Translation Queue" on page 60.

2.1.2 Optimizing Translation Costs

The Optimize Translation feature helps you reduce translation costs, by reducing the quantity of content that
Connector sends to translation providers. It sends only changed content fields out for translation. To do this, it
checks each field of the source version for any content changes.
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore 2.2 The Connector at a Glance

However, this feature needs Connector translation backup data, and it increases the Connector processing time
before sending out the items for translation. For information on enabling Connector translation backup data,
refer to the Clay Tablet Translation Connector for Sitecore Installation and Configuration Guide.

This feature is available:

= by selecting the Sync Translation check box in the Translation Options page of the Bulk Translation wizard,
as described in "Sending Multiple Content Items for Translation" on page 44.

= by selecting the SyncTranslation check box in the Automatic Item Export for Translation dialog box, as
described in "Submitting a Content Item for Translation using the Content Editor" on page 34 and
"Submitting Content for Translation from the Page Editor" on page 39.

Note: You enable this feature when you create an item and attach it to a workflow. For details, see "Attaching a
New Content Item to a Translation Workflow" on page 18.

2.1.3 Selecting a Translation Provider

If your company has multiple translation providers, your company's Connector setup may enable you to select
which one to use when you send out items for translation.

This feature is available:

® in the Translation Queue, as described in "Submitting Content for Translation from the Translation Queue"
on page 60.

= in the Translation Options page of the Bulk Translation wizard, as described in "Sending Multiple Content
Items for Translation" on page 44.

= when sending an individual content item for translation from the Sitecore Content Editor, as described in
"Submitting a Content Item for Translation using the Content Editor" on page 34.

= when sending an individual content item for translation from the Sitecore Page Editor, as described in
"Submitting Content for Translation from the Page Editor" on page 39.

2.2 The Connector at a Glance

You access the Clay Tablet Translation Connector for Sitecore (Connector) directly from the Sitecore user
interfaces—from the Content Editor, the Page Editor, and the Desktop.

Note: Not all Connector features are available in all Sitecore user interfaces.

Sitecore Content Editor

= You can use the CT3 Translation tab in the Sitecore Content Editor to perform multiple translation-
management tasks and to view a summary of the translation status of all the content items in your Sitecore
instance:
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore 2.2 The Connector at a Glance

= You can use the Translate button in the Review tab in the Sitecore Content Editor to send out a single item
for translation:

View  CT3Translation My Toobar

CT3Tranglation My Toobar

Operations

2, ||| @suicer \, dipinnertance i content
= |2 sitecore liame: Type Source: Unversioned  Shared =
& & content CT3Translation
B ) Dealer site
B ) Ncam FieldTypesNesdTranslation TraelistEx E d sitecore/system/Fiald types&datab | [
& ) Globals
@ {JRsS Feeds Translate from Droplink |z| /sitecore/system/anguages B F2
X @ () Calerdr Events Translate to Checklist [=] /sitecore/systemianguages ] [
& B Layout .
& &) Media Lbrary SynchronizeTranslation Chackbox B 5] =
@ ) System ~
2 [ Templotes DaysMe=dBeTrans|ated Integer |E| Il )
B g Branches - - . = = =
Il v
8 () ClayTablets TranslationSendingState Intemal Link E.snecorafsystarrﬂh\fnﬂdms B [
# [E] workflowCT3Config AfterSendingState Intemal Link [=] Vsitecore/systemWorkflows 1 E2
& () common
@ ) Companents InTranslationState Intemal Link E Isitecors/system/\Workflows L] ]
& ) Moduies 1 - ; P
8 svitch TranslationCancelledState Intemal Link E!snecormsystem’h\foncﬂws B E2
@ gm TranslationCompletedState Intemal Link [=] /sitecore/systemWorkflows ] [
B @ System
@ J User Defined AutoTranslateltem\WithConfig Chackbox E B &)
& i) web Forms for Marketers
@ ng : temTranslationSkiphVaitinglnQueue Checkbox Izl B &
¥ (J Calendar TriggerPublishAtFinalState Checkbox [=] m [El
@ () ricam Modues :
@ Stecore Modules PublishingTargetDatabases Checklist [=] /sitecora/systemPublishing targets B @
Content Editer [ EIECER

® YoucanusetheCT3 Sample Workflow workflow to configure your translation workflow:
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore
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2.2 The Connector at a Glance

CT3 Translahon Py Toolbar

B ,f) Marketing Center

E () Maodulas Initial state [shared):
& ) Proxes Workflows/CT3 Sample Workflow/Editing
G Publshing targets
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= E Layout Item Path: [sitecorefaystem Workflows fCT3 Sample Workfiow
&S] Media Library Templata:
= @) System
® () Alases 3 Created From; [unknown]
% Dictionary Item Owner:  [unknown]
# @ Languagss £] bata

[sitecoreftemplates System Workflow Translation\Workflow - {7CEEEBFC-1ADE-4C44-9FC2-FEF409AB53 76}

You can use the Translate To button on the CT3 Translation tab in the Sitecore Page Editor to send a single

content item for translation:

m Hame Advanced Experience Wiew CT3 Translation

w.s (e
Maode

Translate To
Translation

Sitecore Desktop

You can use the menu items in the CT3 Translation folder on the Sitecore menu.
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore

L, | Reporter

& AnalyticsRiefrash
Jennif I DeslerInventary Viewer
- S | Micam report

a Content Edit (@ 5earch Engine Opfimization  #
Manage your { H Sitemapiimi

¢ 4 | Marketing CT3 Translabon
L/ Configure man Archive
features ol Carousel (&l | Display name Translation
= Media Librag : )
EJ Maintain medi il | Content Editor | Translation Fiter
{[#) control Pane & | Translation Quavue
Translation 5tatu
g-i:f:hﬁréﬁ Developer Center EI el 0
3 & | Clear badwp data
iE] File Explarer
Sitecore And
Analyze 'Jsa:nrd Image Editor
» Kt'fbﬂﬂrdl'l‘lup
Security Edil

Grant and rev| EJ | Log Viewer
FETMISSING. | 5] | Media Library

Template M
Create new te EI e

Publish Site |5 Search
Publish your cf Seaurity

Sitecore on the Net

all Application

System
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2.3 Working with Lists

2.3 Working with Lists

The Connector has many list pages, often for displaying lists of content items.

Tips: For lists where you can select multiple items, use the shi ft key to select a range of adjacent items. Use

the ctrl key to select multiple non-adjacent items.

You can perform the following actions in list pages:

k Alist with many items may have multiple pages. You can navigate among pages in a list. For details, see

"Navigating Pages in a List" on page 14.

F You can set the width of a column in the list. For details, see "Setting Column Width" on page 15.

F You can change the column order. For details, see "Changing Column Order" on page 16.

F You can sort the items in the list by a specific column. For details, see "Sorting by Column" on page 15.
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore

2.3 Working with Lists

F You can search for an item in the Translation Status window. For details, see "Monitoring Status for Multiple

Items" on page 68.

F You can group the items in the list by one of the columns in the Translation Status window. For details, see

"Grouping Content Items by Column in the Translation Status window" on page 71.

2.3.1 Navigating Pages in a List

If there are many items in a list, the list may have multiple pages. The navigation bar below the list helps you

navigate through the pages and displays your position in the list.
For example, the Select an Account dialog box may have multiple pages in its list.
" 3 Skecore - Google Chrome == = ]|
citecore/che xaml/Sitecore. Shell Application{l

Select an Account

Selsct & roke oF & user.

Account Type
2 Roles
Users

sitecore\Analybos Reporting

SECOre ) A=

sitecore (hitecore Chent Configuring

I 1 il [ 7] Pape Zof 4 (% 1:1-9

[ o [ caneel |

You use the arrow keys at the bottom of a list to navigate through multiple pages in a list.

Arrow Key What It Does

Opens the first page.

Opens the previous page.

[ B E

Opens the next page.
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore 2.3 Working with Lists

Arrow Key What It Does

|I| Opens the last page.

The bottom right corner of the windows displays the current page in the list, the total number of pages in the

list, and the total number of items in the list. The maximum number of items displayed in a list page depends on
the particular list.

2.3.2 Setting Column Width
You can set the width of any column in a list.
1. Mouse-over theright border of the column.

The cursor is displayed as a white line with arrows at each end.

Language, sion  Type

esES @J Mew Translabon
frFR 2 Mew Translaton
=M 3 Mew Translabon
de-DE 1 Mew Translation
da 1 Mew Translabon

2. Dragthe column border to its new position.
@ Dragging the column border to the left makes the column narrower.

Dragging the column border to the right makes the column wider.

2.3.3 Sorting by Column

By default, items in a list are displayed by alphabetical order of the item in the first column of the list.

You can sort items in a list by any column. For example, suppose that in the Translation Status window, you
want to display all content items by language.

b Click the column heading.

For example, click the Language column heading.

Language  Version Type

es -ES?%I 2 Meve Translaton

fr-FR 2 Meve Translation

#h=CH 3 Meve Translabon

die-DE 1 Mewe Translabon

da 1 Mew Translabon
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2 Getting Started with the Clay Tablet Translation Connector for Sitecore 2.3 Working with Lists

The first time you click in the column heading, the column contents are sorted in ascending order. The arrow
in the column heading indicates the sort order.

La"u;uago Version  Type

da 1 Mew Translation
de-DE 1 Iew Translation
es+ES 2 New Translation
frFR 2 INesw Translation
zh-CN 3 New Translation

k If you want to reverse the sort order, click again in the column heading.

Languagd() Versiin  Type

h-CH 3 Mew Transation
frFR 2 Mew Translation
es-ES 2 Iesw Translation
de-DE 1 MNew Translation
da 1 New Translation

2.3.4 Changing Column Order

You can change the order in which columns in lists are displayed. For example, suppose you want to move the
Language column to the right of the Version column.

1. Click the column heading to move.

For example, click the Language column heading.

Lan e Version Type
:E{:—% Meve Translaton

Z
frFR 2 Meve Translation
zh-CH 3 Heve Translation
die-DE 1 Mew Translabon
1

da Mew Translaton

2. While you hold down the cursor, drag the column heading to the new position. (A copy of the column
heading "floats" above the table.) Red arrows indicate the new position of the column.

es-E5 2 Friew Tranglahnﬂ
frFR 2 Mew Translation
zh-CH 3 Mew Translation
de-DE 1 Mewi Translation
da 1 Mew Translation

3. Release the cursor when the column is in its new position.
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HHNMth

Language
es-ES
FR
zh-CH
de-0E

da

Type

MNew Translation
Mew Translation
Mesw Translation
Mew Translation
MNew Transiation
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3 Creating Content for Translation 3.1 Attaching a New Content Item to a Translation Workflow

3

Creating Content for Translation

m Ifyou are sending a single content item for translation, it must have a translation workflow attached.

# There are three ways to do this when you create a content item:

= Attachittothe sitecore/System/Templates/ClayTablet3/WorkflowCT3Configtemplate.
This template uses the translation workflow, which is contained in the
sitecore/System/Workflows/CT3 Sample Workflow.

. Attach it to your own template. Ensure that your template uses the translation workflow, which is
contained in the sitecore/System/Workflows/CT3 Sample Workflow.

. Attach it to your own template, which uses your own workflow. Ensure that the base template of your
workflowis /sitecore/templates/System/Workflow/TranslationWorkflow. For detailed
instructions, refer to the Clay Tablet Translation Connector for Sitecore Installation and
Configuration Guide.

If a content item was already created, but a translation workflow was not assigned to it, you must assign a
translation workflow to that item. For details, see page 24.

If you are sending multiple content items together using the Bulk Translation feature, you do not need to
attach a translation workflow to individual content items. You can attach a translation workflow and assign a
workflow state to all items without a workflow attached. For details, see "Sending Multiple Content Items for
Translation" on page 44.

3.1 Attaching a New Content Item to a Translation Workflow

To create an item that you can send for translation individually, you must either use a template that has the
Clay Tablet workflow attached, or use a template that is attached to your custom translation workflow.

Note: If you will be sending an item for translation using the Bulk Translation feature, described in "Sending
Multiple Content Items for Translation" on page 44, you do not need to attach a template with a translation
workflow to the item.

1.

In the Sitecore Content Editor, under Content in the navigation pane, locate the place in the tree where you
want to create a new item that will be sent for translation. Next, right-click and select Insert > Insert from
Template in the context menu.

The Insert from Template dialog box opens.
Select one of the following templates:

# The template attached to the default Connector workflow,
Templates/ClayTablet3/WorkflowCT3Config.

@ The template attached to your custom translation workflow, if you have created one.

Click Insert.
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3 Creating Content for Translation 3.1 Attaching a New Content Item to a Translation Workflow

The item opens, displaying the Content tab.
4. Enter the content to translate in the Data section.

5. In the CT3Translation section, specify the following workflow options:

Parameter Description Default Value

Field Types to be Sent Determines which types of fields the Connector can By default, the

For Translation send out for translation when it sends an item for Connector sends
translation. This is relevant for all templates. If you out fields of the
create a custom field type, you must add it to this list so following field types
that you can send it out for translation. for translation:
Note: You cannot set Shared Fields to besentout " t?Xt
for translation, because these fields are shared across all ELCtheXt

m

versions and languages of an item. . .
Single-Line Text

Multi-Line Text

To change these fields, click the Edit button above the
list. In the dialog box that opens, select the field types

to add, and use the blue arrow J to copy them to the
Selected column. When you are done, click OK.

Tip: You can use the shi ft key to select multiple

adjacent field types.
Translate From (Source The source language from which to translate the items. Usually this is the
Language) Select a language from the list. Sitecore default
language.
Translate To (Target The target languages that are available for translating n/a
Language) the items attached to the workflow. To translate into
specific target languages, select the corresponding
check boxes.
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Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Synchronize
Translation (detect
changed content and
resend)

Determines whether the SyncTranslation feature is

available when translating items attached to this

workflow. This feature checks each field of the source

version for any content changes, and it sends only

changed content fields out for translation, to ensure

that all target versions reflect these changes.

= When this check box is selected, you can activate this
feature by selecting a check box in either the Bulk
Translation wizard or the Automatic Item Export for
Translation dialog box. The SyncTranslation feature
may reduce translation costs, but it needs the
Connector translation backup data, and it increases
the Connector processing time before the Connector
sends out the items for translation.

= When this check box is cleared, you cannot activate
this feature, because the related user interface is not
displayed. The Connector sends all specified source
content for translation, even if it has not changed
since it was previously sent for translation.

check box is cleared

Requested Translation
Timeframe (Days)

Determines the translation deadline when sending out
the translation automatically, without using the user
interface that supports entering this information in the
Delivery Date field. This information is sent to the
translation provider as metadata of the translation
package. If you set this parameter to 14, the deadline
will be two calendar weeks after you submit an item for
translation.

Recommendation: Discuss whether to use this feature
with your translation provider(s).

15

Workflow State to set

The workflow state to set when a source item has been

/sitecore/system/

when Sending Content selected for translation. Workflows/CT3
for Translation Sample Workflow/
Sending for
Translation
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Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Workflow State to set
(for Source Content)
once content has been
sent for translation

The workflow state to set for a source item after the
Connector has sent it out for translation. For example,
in some companies, when you send out the content for
translation, the source is ready for publishing. In this
scenario, you can set this state to Done, which is a
publishable state. Alternatively, if your company has a
final review process, you can set this to another state
that is not publishable.

By default, this
state is not set, so
the source item's
state does not
change when you
send it out for
translation.

Workflow State to set
for Content while it is
out for translation

The workflow state to set for target content when an
item is being translated. The default In Translation
workflow state enables you to see which items are still
out for translation. It facilitates following up with your
translator about items that you have sent out for
translation, but that you have not yet received back.

/sitecore/system/
Workflows/CT3
Sample
Workflow/In
Translation

Workflow State to set
when a translation
process has been
cancelled

The workflow state to set when an item’s translation
request has been cancelled.

A user can cancel translation from the Translation
Queue. Atranslation request is automatically cancelled
if a fatal error occurs while sending out an item for
translation, such as an incorrect language code, or
insufficient user permissions.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Reviewing

Workflow State to set
when content
Translation is complete

The workflow state to set when an item translation has
been completed, and it is back in Sitecore for review and
publishing.

/sitecore/system/
Workflows/CT3
Sample Workflow/
Editing Translated
Version

Clay Tablet Translation Connector for Sitecore User Guide

Version 3.6.2

Page 21
February 25, 2014




Creating Content for Translation 3.1 Attaching a New Content Item to a Translation Workflow

Parameter Description Default Value
Send Content Enables sending all items to the Translation Queue check box s cleared
automatically using without further user action. That is, the Connector

pre-configured automatically uses the Translate from, Translate to and

language settings Requested Translation Timeframe information, defined

above, to immediately send content to the Translation

Queue without enabling the user to change these

parameters: the Language Selection pop-up window

does not open.

= [f this check box is selected, the Language Selection
pop-up window does not open when you send
content to the Translation Queue: you cannot select
the target languages or the destination, but sending
items for translation is streamlined.

m Ifthis check box s cleared, the Language Selection
pop-up window opens when you send content out
for translation: you can select the target languages,
so the process is less streamlined. However, this
provides greater control for the user.
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Creating Content for Translation

3.1 Attaching a New Content Item to a Translation Workflow

Parameter

Description

Default Value

Send Content
immediately, skipping
the Translation Queue

The Connector separates the process of sending an item
for translation into two steps, which enables a company
to set up user permissions for each step based on its
own translation business logic:

1. Addingtheitem to the Translation Queue.

2. Sending out the queued items from the Translation
Queue.

This setting enables a user to skip the queuing step and
send out an item for translation immediately.

Recommendation: Select this check box only if content
editors are allowed to incur translation costs, because
the Connector sends out content without further
review or approvals.

m If this check box is selected, the Connector sends out
items for translation immediately, bypassing the
Translation Queue.

m If this check box is cleared, the Connector sends
items to the Translation Queue before it sends them
out for translation.

Important: This parameter is not currently supported.

check box is cleared

Automatically Publish
content when it
reaches the Final State

Determines whether the Connector automatically
publishes the content when an item reaches the final
state of the translation workflow.

m If this check box is selected, the Connector
automatically publishes the content when an item
reaches the final state.

m If this check box is cleared, the Connector does not
automatically publish the content when an item
reaches the final state.

check box is
selected

Publish to which
Database?

The target databases for publishing content if the
Connector needs to publish an item.

n/a
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3 Creating Content for Translation 3.2 Attaching a Translation Workflow to an Existing Content ltem

Parameter Description Default Value
Publish child items? Determines whether the Connector publishes child check box is
items when it publishes their parent item. selected

m Ifthis check box s selected, the Connector publishes
child items when it publishes their parent item.

m If this check box is cleared, the Connector does not
publish child items when it publishes their parent
item.

3.2 Attaching a Translation Workflow to an Existing Content Item

If you have a content item that is attached to a template that does not include a translation workflow, you can
still prepare to send it out for translation individually. To do so, you assign a translation workflow to the content
item.

Note: You can assign a translation workflow to a content item only if you can assign a workflow to that content
item. This means that the content item must inherit the workf1ow data item from its data template. For more
information, refer to the Sitecore Data Definition Reference. This guide is available in the documentation section
of the Sitecore Developer Network (SDN) site, at http://sdn.sitecore.net/Reference.aspx. You must log in to this
site to access the documentation.

To attach a translation workflow to an existing content item:

1. Inthe Sitecore Content Editor, navigate to the content item to which you want to attach a translation
workflow and select it.

2. Inthe Sitecore Content Editor ribbon, click the Review tab.
3. In the Workflow section, click Edit.

Tip: If the Workflow section is not visible, then in the Sitecore Content Editor ribbon, click the View tab and
select the Standard Fields check box.

4. Inthe Content tab, scroll down to the Workflow section.

5. If necessary, click the Expand button # to expand the Workflow section.
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3 Creating Content for Translation 3.3 Filtering Fields in Items that Do Not Need Translation

T Worlkdlow

Workflow
Workflows/CT2 Sample W

State:
Workflows/CT3 Sample Wi

Lock:

<r >

Default workflow

6. Inthe Workflow field, click the arrow to select CT3 Sample Workflow oranother translation workflow.
7. Optional. In the State field, click the arrow to select the workflow state.

8. In the Review tab on the Sitecore Content Editor ribbon, in the Workflow section, click Check In.

3.3 Filtering Fields in Items that Do Not Need Translation

You can use the Translation Filter window to filter out fields that never need translation. You can access this
feature from either the Sitecore Content Editor or the Sitecore Desktop.

You initially specify which types of fields the Connector sends for translation using the Field Types to be Sent
For Translation workflow-level parameter. For details, see "Attaching a New Content Item to a Translation
Workflow" on page 18.

You use the Translation Filter feature to further exclude certain types of fields from content that the Connector
sends for translation, per the template. You can create filters when initially configuring the Connector, or you
can create or update the filters at any time.

When a user sends out an item for translation, the Connector collects the content from all fields in the item with
the field types specified in that parameter, in preparation for sending them out for translation. Then, if there are
some fields that you do not want to send for translation, even though they belong to field types that the
Connector sends out for translation, you can use the Translation Filter to exclude them.

1. Do one of the following to open the Translation Filter window:

In the Sitecore Content Editor ribbon, click the CT3 Translation tab, and then in the Translation Tools
section, click Translation Filter.
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3 Creating Content for Translation 3.3 Filtering Fields in Items that Do Not Need Translation

Analyre Putdish Versions Configure Presentaltion

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CT3 Translation >
Translation Filter from the menu.

The Translation Filter window opens.
If you use the Sitecore Content Editor, it opens in a separate browser window.

If you use the Sitecore Desktop, it opens in the same browser window.

Transkation Filter

; |
) g3 s ‘-@H
Delete Al Fiters Delete the selected Filters = Add  Fiter sslected fisld for ALL || Refresh
(Aers | Operations | View |

Template Path

Dot transfer figd vake

Field Mame Futld Type

[fremplates Components LandngPage Landi. . Variants Multdizt falee
ftemplates ComponentsLandingPage Landi... Retired Checkbox true
Stemplates Components MevwsItem MNewsltem  Description Rich Text true

ftemplates Components MewsItem Mewsltem Short Descripbon Rich Text false

* ]| Page 1of 1 ($items)

2. Click the Add button to add a new filter.
The Welcome page of the Field Filter wizard opens.
3. Click Next.

The Choose a Content Template page of the CT3 Field Filter wizard opens.

Clay Tablet Translation Connector for Sitecore User Guide Page 26
Version 3.6.2 February 25, 2014
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¥ Sitecore - Google Chrome =
[ sitecore/shell/default.aspx?xmlcontrol=CT3_AddFilter F

Choose a content template
Please dhoose the Comtent Template with the fields you want fitered and therefore not sent for translabon.

Choose a Content Template

= [E] Templates
& i Branches
® () cayTablets
(%) 'L-l Common
= ) components
E (JLandingPage
[£] LandingPage
[E] LandingPagevariant1
] LandingPagevariant2
[£] LandingPagevariant3
£l mp
E] _templatedefinition B

m

[ <Back | mext> | [ canced |

4. Select the content template to associate with the fields you want to filter, and exclude from translation. Use
the Expand = and Collapse = icons to navigate the tree. Click Next.

The Select Fields that you don't want sent out for translation page of the Field Filter wizard opens.
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([ 3 = El] ]
[ )/sitecore/shell/defaultaspx?xmlcontro T3_AddFilter F |

Select Fields that you don't want sent out for translation
Salect Fields that should not be sent for translation. Mote: Shared Fields are never sent out for ranslaton. E
They are vishle for reference only,

Field Type Shared  Template
B I nvame Single-Lne Text [(shared) LandingPage
[ @ variants  Mutiist LandingPage
;_-:I Abasg Single-Line Text LandingPage
B Description  Single Line Text LandingPage
:I ¥| RAetred Cheddax Landingfage

This page displays the following information about all the fields in the template you selected:

Column Description

Field The name of a field type in the template.
Type The description of the field type.

Shared Indicates whether the field type is shared.
Template The template where the field type is located.

5. Select the check boxes of the field types you want to exclude from translation, and click Next.

Note: Shared fields are never sent for translation, so they are automatically excluded from translation. You
do not need to select them.

The Don't transfer field value page of the Field Filter wizard opens.
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3.3 Filtering Fields in Items that Do Not Need Translation

€

Don't transfer field value

i fsiecore;/sne

Select the filered fislds whaose field data be should also NOT be copied to the target version, E

Dion't ransfer field value Feld
= M Variants
= = Retired

Cheddox  LandingPage

<Back || Mext> | | cancel

This page displays only the field types you selected in the previous page of the wizard.

6. For each field type, indicate whether you want the Connector to copy the source-language content to the

target version.

If you want the Connector to copy the source-language content of a field type to the target version, select
the corresponding check box. This field type will be included in the target content; however, the content

will be in the source language.

If you do not want the Connector to copy the source-language content of a field type to the target
version, clear the corresponding check box. This field type will be excluded from the target content.

Click Next.

The summary page of the wizard opens.
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3 Creating Content for Translation 3.3 Filtering Fields in Items that Do Not Need Translation

[3 =1 (=]

The CT3 Filter wizard is complete. Click Finish to
close the wizard.

The selected Felds have been added to the Translation Filker:

= Template Fekd Type Don't ransfer fiald value
=] 1 LandngPage Variants Mutilst
_'] 2 LandngPage Retired Cheddbox Yes

< Badk MNext = Finish, ]

This page displays the following information about the fields to exclude in the new filter.

Column Description

Template The name of the template where the field type to exclude from translation is located.
Field The name of the field type to exclude from translation.

Type The type of field to exclude from translation.

Don't transfer |Indicates whether the Connector copies the source-language content to the target version

field value for this field type.

= Blank indicates that the Connector does copy the source-language content of a field to
the target version, select the corresponding check box. This field will be included in the
target content; however, it will be in the source language.

m yes indicates that the Connector does not copy the source-language content of a field
type to the target version. The Connector does not automatically transfer the value of
the field in the source version to the field in the target version.

7. Click Finish.

The wizard closes, and the CT3 Translation Filter window displays each filter you created in a separate row:
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3 Creating Content for Translation

3.3 Filtering Fields in Items that Do Not Need Translation

I 7 CT3 Translation Filter - Google Chrome = O] =
i tecore/shs tecore/conten | CT it 150 F
Delete All Fiters  Delete the selected Filters | Add  Fiter selected field for ALL || Refresh
Template Path Fiehd Mame Feld Type Dion't transfer field value
[templates Components/LandngPageLand...  Variants Multlist false
[templates (Components LandngPage/Land... Retired Checkboo true

|

Page 1 of 1 (2items)

This window displays the following information about the filters:

Column |[Description

Template [The path and name of the template. Field types in this template can be excluded from

Path translations.

Field When the Connector sends out content items based the specified template for translation, it
Name does not send out this field's content for translation.

Field The type of this field.

Type

Don't Indicates whether the Connector copies the source-language content to the target version for
transfer |this field type.

field ®m false indicates that the Connector does copy the source-language content of a field type to
value the target version, select the corresponding check box. This field will be included in the target

content, however it will be in the source language.

®m true indicates that the Connector does not copy the source-language content of a field to
the target version. The Connector does not automatically transfer the value of the field in the
source version to the field in the target version.

Now that you have created a filter, you can perform the following actions in the CT3 Translation Filter
window (in addition to the Add Filter button, which was described above in step 3):

Button Description

Dedete Al Filters

Deletes all filters displayed in the CT3 Translation Filter window.

Delete the selected Fiters

Deletes all selected filters from the CT3 Translation Filter window.

Fitter selected field for ALL

Applies the selected filter to all templates with the same field type.
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3 Creating Content for Translation 3.3 Filtering Fields in Items that Do Not Need Translation

Button Description

Refreshes the list of displayed filters.
Refresh
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4 Sending Content to Translation 4.1 Workflow States

4 Sending Content to Translation

If you send a single content item for translation, it must be in a workflow state that enables it to be sent for
translation. This corresponds to the Reviewing workflow state that is part of the default cT3
SampleWorkflow translation workflow. If you send multiple content items for translation using the Bulk
Translation feature, you can assign a workflow and workflow state to the items at that time.

When the Connector sends out content items for translation, the following events occur:
1. The Connector exports the content from the Sitecore CMS as HTML or XML files. The format is determined

by the ClayTablet.PackedFileFormat settinginthe CT3Translation.config file. For details, refer
to the Clay Tablet Translation Connector for Sitecore Installation and Configuration Guide.

2. The Connector creates placeholders for the content of the language versions of the specified target
languages.

3. The Connector delivers the export files to the Clay Tablet Platform, along with information about the target
languages, and source location within Sitecore. The Clay Tablet Platform then delivers these files to the
translation provider(s) specified in your company's routing rules.

Note: Using the translation workflow for a content item does not obligate you to send out that content item for
translation. You can move the content item through the entire workflow without sending it out for translation.

4.1 Workflow States

The sitecore/System/Workflows/CT3 SampleWorkflow workflow contains all required states for the
Connector translation management process.

By default, it has the following seven states, which are listed, in order, below.

Workflow State Relevant for Source Content Relevant for Target Content
Editing v

Reviewing v

Sending for Translation v

In Translation v

Editing Translated Version v

Reviewing Translated Version v
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4 Sending Content to Translation 4.2 Submitting a Content Item for Translation using the Content Editor

Workflow State Relevant for Source Content Relevant for Target Content

Done v 4

Note: Only content in the Done state is publishable.

4.2 Submitting a Content Item for Translation using the Content Editor

This section describes how to submit a content item for translation using the Sitecore Content Editor. It is
relevant only for a single content item that uses a template that has a translation workflow attached, as
described in "Creating Content for Translation" on page 18. For instructions on submitting multiple content
items for translation, see "Sending Multiple Content Items for Translation" on page 44. For instructions on
submitting a single content item for translation using the Sitecore Page Editor, see page 39.

Depending on your company's Connector configuration, when you submit the item for translation, either:
®m The Connector immediately sends out the item for translation.

= The Connector sends the item to the Translation Queue, which is a holding area for items that are ready for
translation.

To submit a content item for translation:

1. Inthe Sitecore Content Editor, navigate to the content item that is ready to sent for translation and select
it.

2. Inthe Sitecore Content Editor ribbon, click the Review tab.
3. In the Workflow section, click Submit.

Note: The Submit button is displayed only if the content item's workflow state is Editing.

A dialog box opens.

£  Sitecore - Webpage Dialog ]

| e  hitp:// 'sitecore/shell/ prompt.htmil -

Enter a comment:

[c:-c_-c.znw

hittp://192.168.1 ! & Intemnet | Protected Mode: On
— —_—
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4 Sending Content to Translation 4.2 Submitting a Content Item for Translation using the Content Editor
4. Optional. Add a comment to this action. The Connector does not use this comment, but it is available in
Sitecore.

The content item moves to the next state in the workflow, which is Reviewing.
The Workflow section of the Review tab is updated to display the Publish, Reject, and Translate buttons.

Note: These buttons are displayed only if the content item is in the Reviewing workflow state.

Analyze Publish Versions  Configure Presentation  Seourity View  CT3Translation My Toobar

Valdation Subscribe -~ SEO Analysis H\rllrrrs

H ? B a g d D | Cick Edit to lock and edit this item, ?m r.;hm.;u .ﬁ.@

Note: Using the translation workflow for a content item does not obligate you to send out that content item
for translation. You can move the content item through the entire workflow without sending it out for

translation.

5. Click Translate.

6. Optional. Depending on your company's Sitecore configuration, an additional comment box may be
displayed. If so, you can enter a comment and click OK.

The next step depends on your company's Connector configuration. Usually, the Automatic Item Export for
Translation dialog box opens.
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> =@ = ]

1 : fsitecore/shell/default.aspx?xmlcontrol=CT3_Translation&item ‘I'i—l‘l‘-':F

4 Sending Content to Translation

Automatic Ttem export for translation

Send Sitecore items for translation, automatcally

Translate fsitecore/content/Global/Carcusels {Home Page [en Vi1 ]
To Language
[ Danish : dansk
] German (Germany) : Deutsch (Deutechland)
| French (France) : francais (France)

| 1apanese (Japan) : S8 (5 %)
[l ehinese (simpified, china) : + (% A\ BAEE)

Trarsdation Option
[ ] syneTrangation (Only send out changed content for translation),

Send To Options

Send items to ranslation queue
9 Send items to translation provider

Sand to: lMachine_Translation El

Job Mame

Debvery Date  12/25/2013 »
PO Reference

Description

Copy source to target anly

The following options may be available, depending on your company's Connector configuration:

Option Description
To Select the target languages into which you want to translate the content.

Language |Note: Depending on your company's Connector configuration, some languages may already
be selected. If so, you can clear any selected languages that you do not want to include.
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Option Description

Sync Determines whether to check each field of the source version for any content changes, and

Translation |send only changed content fields out for translation. If a field was previously translated and it

has not changed, then the Connector does not send it for translation again: Instead, it uses

the stored translation.

= When this check box is selected, the Connector sends only changed content fields out for
translation. This may reduce translation costs, but it increases the processing time before
the Connector sends out the items for translation.

= When this check box s cleared, the Connector sends all specified source content for
translation, even if it has not changed since it was previously sent for translation.

Note: This option may not be available, depending on the setup of the content item to the
attached translation workflow. For details, see the description of the SynchronizeTranslation
feature in "Attaching a Translation Workflow to an Existing Content Item" on page 24. This
option may also not be available based your company's Connector configuration. For details,
refer to the description of the SynchronizeTranslation setting in the Clay Tablet Translation
Connector for Sitecore Installation and Configuration Guide.

Select one of the following Send To Options:

Send items |The Connector sends the content item to the Translation Queue, where a user must approve it
to to send it out for translation.

translation
gueue
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4 Sending Content to Translation 4.2 Submitting a Content Item for Translation using the Content Editor

Option Description

Send items |The Connector sends the content item to the Clay Tablet Platform, which sends it to the

to translation provider specified in the company's routing rules. The Connector displays
translation |additional fields below, where you can specify additional information.
provider

Note: This option may not be available, depending on your company's Connector
configuration, which may require that all content items are sent to the Translation Queue for
further approval.

Recommendation: Select this option if you need to quickly send out content and do not need
to arrange or filter it, for example, by language.

Send To: If your company has multiple translation providers, and if your company's
Connector configuration enables selecting the translation provider (instead of using
automatic routing rules), you can select the provider for this item in the dropdown list.
Job Name: Your name for this translation job.

Delivery Date: The requested translation deadline. This is the date when you expect the
translated content to return. By default, it is two weeks from the current date. To select a
different date, either type the delivery date in the field in MM/DD/YYYY format, or click the
arrow and select a different date in the calendar that opens. This information is sent to the
translation provider as metadata of the translation package.

Note: The default displayed date is based on your company's Connector configuration.

Recommendation: Discuss with your translation provider whether to use the information in
this field.

PO Reference: The purchase order reference number.
Description: A description of the translation job, including any special instructions or
requests.

Copy The Connector copies the source content to the target content item without sending it out for
sourceto [translation. This is useful in scenarios where there is content that you do not want to translate,
target only |but that you want to include in the target version. Connector displays an additional field
below, where you specify the job name.

Job Name: Your name for this job.

7. Click OK to close the dialog box and send the content item to the next step, as described above.

If you sent the content item to a translation provider, or copied the source content to the target, the Job
Progress box opens, indicating the Connector's progress in sending out the item for translation or
copying over the content. Each target language represents an item. Click Close at any time to close the
Job Progress box. The processing and sending continues in the background.
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€ == 2 |
| 4 tecore/shell/defaultaspx?xmlcontrol=CT3_Send nglobStatus&jobld=83a _"'F |

==| Job Progress

Send Sitecore items out for translation

Sending job "My Job'. It is safe to close the wizard at any time, the job will be sent in background.

= Preparing Sending Sent to CTT In Translation RFeceived Completed
) Numrber of items: 0 3 0 0 0 2

Processing prepared transiaton items (en->fr#R): 0/1... 3 '|

If you sent the content items to the Translation Queue, a message box opens, indicating that the
Connector sent the content and the source and target languages. Click OK to close the message box.

Important: If the Connector sent the item to the Translation Queue, you must approve it there to send it
out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 60.

The page at | says:

ltemn translation: fsitecore/content/Global/Carousels/Home
Page Caribbean

From: en (V:1)

To: dafd,de-DEN,fr-FRID ja-IPN,zh-CHED

has been added to CT3 Translstion Queue,

0K

Note: The Connector never sends out shared fields for translation, because these fields are shared across all
versions and languages of an item.

For information about the events that occur when the Connector sends out content for translation, see
"Sending Content to Translation" on page 33.

Tip: You can monitor the translation progress from within the Sitecore Content Editor. For detailed instructions,
see "Monitoring Translation Status" on page 66.

4.3 Submitting Content for Translation from the Page Editor

This section describes how to submit a content item for translation using the Sitecore Page Editor. Depending
on your company's Connector configuration, when you submit the item for translation, either:
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4.3 Submitting Content for Translation from the Page Editor

= The Connector immediately sends out the item for translation.

= The Connector sends the item to the Translation Queue, which is a holding area for items that are ready for

translation.

For instructions on submitting a content item for translation using the Sitecore Content Editor, see page 60.

1. Inthe Sitecore Page Editor ribbon, click the CT3 Translation tab.

A < &

Edit | Preview - Translate To

=

| Home  Advanced Experience View  CT3 Translation

2. Inthe Translation section, click the Translate To button.

Note: This button is displayed only if the content item is in the Reviewing workflow state.

3. Optional. Depending on your company's Sitecore configuration, an additional comment box may be

displayed. If so, you can enter a comment and click OK.

The Automatic Item export for translation dialog box opens.
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> =@ = ]

1 : fsitecore/shell/default.aspx?xmlcontrol=CT3_Translation&item ‘I'i—l‘l‘-':F

4 Sending Content to Translation

Automatic Ttem export for translation

Send Sitecore items for translation, automatcally

Translate fsitecore/content/Global/Carcusels {Home Page [en Vi1 ]
To Language
[ Danish : dansk
] German (Germany) : Deutsch (Deutechland)
| French (France) : francais (France)

| 1apanese (Japan) : S8 (5 %)
[l ehinese (simpified, china) : + (% A\ BAEE)

Trarsdation Option
[ ] syneTrangation (Only send out changed content for translation),

Send To Options

Send items to ranslation queue
9 Send items to translation provider

Sand to: lMachine_Translation El

Job Mame

Debvery Date  12/25/2013 »
PO Reference

Description

Copy source to target anly

The following options may be available, depending on your company's Connector configuration:

Option Description
To Select the target languages into which you want to translate the content.

Language |Note: Depending on your company's Connector configuration, some languages may already
be selected. If so, you can clear any selected languages that you do not want to include.
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Option Description

Sync Determines whether to check each field of the source version for any content changes, and

Translation |send only changed content fields out for translation. If a field was previously translated and it

has not changed, then the Connector does not send it for translation again: Instead, it uses

the stored translation.

= When this check box is selected, the Connector sends only changed content fields out for
translation. This may reduce translation costs, but it increases the processing time before
the Connector sends out the items for translation.

= When this check box s cleared, the Connector sends all specified source content for
translation, even if it has not changed since it was previously sent for translation.

Note: This option may not be available, depending on the setup of the content item to the
attached translation workflow. For details, see the description of the SynchronizeTranslation
feature in "Attaching a Translation Workflow to an Existing Content Item" on page 24. This
option may also not be available based your company's Connector configuration. For details,
refer to the description of the SynchronizeTranslation setting in the Clay Tablet Translation
Connector for Sitecore Installation and Configuration Guide.

Select one of the following Send To Options:

Send items |The Connector sends the content item to the Translation Queue, where a user must approve it
to to send it out for translation.

translation
gueue
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Option Description

Send items |The Connector sends the content item to the Clay Tablet Platform, which sends it to the

to translation provider specified in the company's routing rules. The Connector displays
translation |additional fields below, where you can specify additional information.
provider

Note: This option may not be available, depending on your company's Connector
configuration, which may require that all content items are sent to the Translation Queue for
further approval.

Recommendation: Select this option if you need to quickly send out content and do not need
to arrange or filter it, for example, by language.

Send To: If your company has multiple translation providers, and if your company's
Connector configuration enables selecting the translation provider (instead of using
automatic routing rules), you can select the provider for this item in the dropdown list.
Job Name: Your name for this translation job.

Delivery Date: The requested translation deadline. This is the date when you expect the
translated content to return. By default, it is two weeks from the current date. To select a
different date, either type the delivery date in the field in MM/DD/YYYY format, or click the
arrow and select a different date in the calendar that opens. This information is sent to the
translation provider as metadata of the translation package.

Note: The default displayed date is based on your company's Connector configuration.

Recommendation: Discuss with your translation provider whether to use the information in
this field.

PO Reference: The purchase order reference number.
Description: A description of the translation job, including any special instructions or
requests.

Copy The Connector copies the source content to the target content item without sending it out for
sourceto [translation. This is useful in scenarios where there is content that you do not want to translate,
target only |but that you want to include in the target version. Connector displays an additional field
below, where you specify the job name.

Job Name: Your name for this job.

4. Click OK to close the dialog box and send the content item to the next step, as described above.

If you sent the content item to a translation provider, or copied the source content to the target, the Job
Progress box opens, indicating the Connector's progress in sending out the item for translation or
copying over the content. Each target language represents an item. Click Close at any time to close the
Job Progress box. The processing and sending continues in the background.

Clay Tablet Translation Connector for Sitecore User Guide Page 43

Version 3.6.2 February 25, 2014



4 Sending Content to Translation 4.4 Sending Multiple Content Items for Translation

€ =lE] = |
| 4 tecore/shell/defaultaspx?xmlcontrol=CT3_Send nglobStatus&jobld=83a _"'F |
==| Job Progress

= Send Sitecore items out for translation

Sending job "My Job'. It is safe to close the wizard at any time, the job will be sent in background.

= Preparing Sending Sent to CTT In Translation RFeceived Completed
) Numrber of items: 0 3 0 0 0 2

Processing prepared transiaton items (en->fr#R): 0/1... 3 '|

If you sent the content items to the Translation Queue, a message box opens, indicating that the
Connector sent the content and the source and target languages. Click OK to close the message box.

Important: If the Connector sent the item to the Translation Queue, you must approve it there to send it
out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 60.

The page at | says:

ltemn translation: fsitecore/content/Global/Carousels/Home
Page Caribbean

From: en (V:1)

To: dafd,de-DEN,fr-FRID ja-IPN,zh-CHED

has been added to CT3 Translstion Queue,

0K

Note: The Connector never sends out shared fields for translation, because these fields are shared across all
versions and languages of an item.

For information about the events that occur when the Connector sends out content for translation, see
"Sending Content to Translation" on page 33.

4.4 Sending Multiple Content Items for Translation

The Bulk Translation feature enables you to select, send, and receive large quantities of content for translation
in only a few clicks.
This is useful for quickly sending out entire sections, sites, or content trees for translation.

You access the Bulk Translation feature from either the CT3 Translation tab on the Sitecore Content Editor
ribbon, or from the Start menu on the Sitecore Desktop.
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Important: When you use the Bulk Translation tool, you can initially select a large set of content items, based
on the content navigation tree, and then in subsequent steps you exclude items from that group that you do
not want to send out for translation.

Bulk translation and workflow

Recall that you do not need to attach a translation workflow to the content items when you use the bulk
translation feature. However, the Assign Translation Workflow to items with no workflow defined? option in
the wizard enables you to attach a workflow to the items you send out, and you can set the workflow state for
those items. This is recommended because it helps manage those items later, especially in the workbox.

Recommendation: Plot out your requirements before starting the Bulk Translation wizard, because this feature
has powerful implications. Consider the following issues:

m Does every item already have a workflow attached?

= If every item does not already have a workflow attached, do you want to attach the translation workflow to
those items?

m If you want to attach the translation workflow to items previously without a workflow, which workflow state
do you want to assign to those items?

m What are the repercussions of attaching the workflow and assigning the workflow state to these items?

To send content for translation using the Bulk Translation feature:

1. Do one of the following to open the Bulk Translation wizard:

In the Sitecore Content Editor ribbon, click the CT3 Translation tab, and then in the Translation Tools
section, click Bulk Translation.

o Home Mavigale Review Anayre Puslish Versons Configure Presantation Security Wi CT3 Translation

(L) Bulk Translstion ) ] Translation Queue g Clear backup data In Gueve: 3 Sentto CTT: 11

] SantwmISP €
Save || |2) Translabon Fitter ] Translation Status ] Item Transiation Details || Sanding: 0 In Trarslation: 2

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CT3 Translation >
Bulk Translation from the menu.

The Welcome page of the Bulk Translation wizard opens.
2. Click Next.

The Settings page of the wizard opens.
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E = (B 2
|:: L }/sitecore/shell/defaultaspx?xmlcontrol=CT3_BulkTranslation&itemID=%7b110D559F-DI 'l"-.'“'
Settings

Select the translation language settings. Then didk Next to select items. E
Sowrce Languape =
English - English [~]

Translate these items into the folowing Target Languages
[]es-CZ Czech (Czech Republic) : cestina (Ceska republika)
[[Tds  Darish : dansk

|| deDE German (Germany) : Dewutsch (Deutschland)

[] es£5 Sparish (Spain) : espafiol (Espafia)

[] es®A Sparish (Panama) : Espafial (Panama)

[T fi#FT  Firnish (Firkand) : suomi (Suomi)

[7] &FR French (France) : francais (France)

[T heiL Hebrew (Israel) : D) ALY

[T T Italian (taly) : italiana (taia)

[[]ja-P Japanese (Japan) : B=48 (2=)

[] MO Nerwegian, BokmBl (Merway) : narsk, bokmal (Narge)
[T L Duteh Metherlands) : Mederlands (Mederland)

|| e Ukrainian (Ukrane) @ yrpsineods (Yepaka)

[[] zn-CN Chinese (People’s Republc of China) : & 1(+4% 0 ExE)

m

Ttems to send
9 Selectitems to send
' Select items sent in past jobs | Sert by job name | Sort by creaton ome |
Job Hame Creation Time -
2] Rk's NEW Swedish demo  10/17/2013 9: 15:45 AM E
2] Fk's swedich dema 10/17/20129:12:03 AM
[£] Fik's high tech demo 10/15/2013 3:05:14 PM

e i i

[ <Back | mext> | [ Cancel

3. Inthe Settings page, you choose the following settings:

Setting Description

Source Language The Connector will send items in this source language for translation. By default this
is the default Sitecore language. You can select another language from the list.

Translate these Select the check boxes for all the target languages into which you want to translate

items into the the source content. The list displays all the Sitecore languages that are set up for the

following Target Connector.

Languages Note: In a later step of this wizard, you can select individual content items from the

list of content items and modify their target languages. This is useful for any specific
exceptions that may require special target language treatment.
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Setting Description

Items to send This section displays the names of items you can send for translation and the date
and time they were created. By default, these items are sorted in order of reverse
chronological creation date.

To sort these items by name, click Sort by job name.

To sort these items by date, click Sort by creation date.

You can choose one of the following settings:

Select items to send: This displays all items in the specified source language.
Select items sent in past jobs: This displays all items in the specified source
language that were previously sent for translation.

Note: Later in the wizard you can exclude items from this list.

When you are done, click Next.

Ifin the previous step you selected Select items to send, then the Root of Source Item page of the
wizard opens. Proceed to the next step.

Ifin the previous step you selected Select items sent in past jobs, then the Translation Options page of
the wizard opens. Proceed to step 8.

4. Inthe Root of Source Item page, you select the highest-level root folder of all source items to send for
translation. In later steps, you can exclude items so that you do not send them for translation. In addition,
content selected using the Bulk Translation feature is sent by default to the Translation Queue, which
enables you to further sort and select the items to send for translation.
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I ¥ Sitecore - Google Chrome = | [=] x
3 /sitecore/shell/default.aspx?xmicontrol=CT3_BulkTranslation&itemID=%7b110D559F-DEAS M

Root of Source Ttem
Choose the Content Root for items requiring translabon. You can select individual items in the next step. Be careful - you can select MANY ibems with
this feature.

Root of the Source Ttems
= o Content
=l ¥ Dealer site
B i) Settings
= i) Products
# 3 Mew Products
7 ) Digital LR
% Y Digital P and §
= W Lermes
* 3 Accessaries
= ) Events
& W Calendar Settings
0} My Inventory
£ ") Order
@ ) Dealer orders
& i Irventary
ol iicam
# 5 Micam
4 ] Globals
7 () RSS Feeds
# ) Calendar Events

[ <pack || mext= | [ cancel

Use the Expand = and Collapse =l icons to navigate the tree and include the highest root folder of all source
items to send for translation.

Tip: If you specify the highest root in your Sitecore project, all content from a site or Content Server, you can
send all your project content for translation at one time.

When you are done, click Next.
The Specify Source Filters page of the wizard opens.
5. Inthe Specify Source Filters page, you specify the filters to apply to the source content, which limits the

content that you send for translation. It enables you to apply very specific conditions and precisely control
which content you send out for translation. For example, using the filters on this page, you can select all the
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items created by a certain user, during a given date range, and then send only the latest version of those
items.

Important: These filters are inclusive parameters. Only items that match all filter parameters will be available
for further selection on subsequent pages of the wizard.

¥ Stecore - Google Chrome = [I= [
[ )/ sitecore/shell/default.aspx?xmicontrol=CT3_BulkTranslation&itemID=%7b110D559F -DEASM
Specify Source Filters

Specify the filters that you want to apply to the source, Click Next to continue,
Item version fiter °

Send only the Latest Version [ =]

Creation date fter

From ¥ | Clear Filter
To o

Modification date filter

From -
To L

a1l

Publish date filter
Publish Date ™ | Clear Filter
[ Take workfiow into account

Created by filter

) community\Wildife_Community
] community\Wedding_Community
[£] extranetiforum

[£] extranetiebay

[£) extranetichris o

[Remave | | Clear Filter |
Updated by fiter

[} extranetiDeater

You can use the following filters:
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Filter Description
I[tem version You filter the version or versions of the content items that the Connector sends out for
filter translation. The following options are available:

Send only the latest version: The Connector sends only the latest version of content
for translation. This is the default selection.

Send the latest published version: The Connector sends only the latest published
version of content for translation. This is suitable when a company publishes content
before sending it for translation.

Send all published versions: The Connector sends all published versions of content for
translation.

Send all versions: The Connector sends all versions of content for translation.

Note: If you select one of the last two options, the Connector sends multiple versions of
the same content items for translation.

Creation date
filter

You filter the creation date of the content items that the Connector sends out for
translation. In the From and To fields, either enter the range of content-creation dates in
MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.

Modification You filter the modification date of the content items that the Connector sends out for
date filter translation. In the From and To fields, either enter the range of content-modification dates
in MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.

Publish date You filter the publication date of the content items that the Connector sends out for
filter — Publish [translation. In the Publish Date field, either enter the content-publication date in
Date MM/DD/YYYY format, or click the arrow and select a date from the calendar that opens.
Publish date This setting determines whether the Connector checks the Publish date filter.
filter — Take If this check box is selected (default value), then the Connector includes in the filter only
workflow into items that both match the publish date and those that need publishing to be approved
account through the workflow.

If this check box is cleared, then the Connector includes in the filter items that match

the publish date whether or not publishing must be approved through the workflow.
Created by You create a filter based on who created the content item. This can be either users, or
filter roles assigned to users, or both.

To add a filter to this list, click Add. For detailed instructions, see page 58.

To remove a filter from this list, select it and click Remove.
Updated by You create a filter based on who updated the content item in Sitecore. This can be either
filter users, or roles assigned to users, or both.

To add a filter to this list, click Add. For detailed instructions, see page 58.
To remove a filter from this list, select it and click Remove.

Tip: To clear the information from any filter, click the corresponding Clear Filter button.

When you are done, click Next.

The Excluding Item(s) page of the wizard opens.
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6. Inthe Excluding Item(s) page of the wizard, you can precisely control the translation parameters for each
content item you sent for translation. This helps you manage any exceptional translation requirements. You
can:

Remove content items from the list, so that you do not send them out for translation.

Change the target language of each item to send out for translation. For example, you may select a
section of your web site to be bulk exported for translation into German, but you want to translate the
top-level page items of that section into Spanish and French too.

Change the version of each item to send out for translation for each target language. For example, you
may want an older version of the source content translated into a specific target language.

| /sitecore/shell/defaultaspxTxmlcontrol=CT3_BulkTranslation&itemID=%7b814864CB IIE_T:FF

Excluding Ttemi(s)
Remave the Items that don't require translation,

[tem = | —Target language and version
=] | jeitecore/content Global [Arports /Australia/Melbourne Airport

._'I [ Jsitecore feontent Clobal \Airports Australia Sydney Kingsford Smith
[E) [ fsitecorejcontent/Global jirports Belgum Brusssls Arport (] deDE  version: 0
.:l |} Jsitecore fcontent Global (ArportsCanada Toron o Pearson Interna [¥] frFR Versiom: [0
[£) [ fsitecore content fClobal fairparts fChina Beijing Capital Internationa
.:l |7} fsitecore fcontent /Global fArpartsChina/Mong Kong International Ai
._'I [ feitecore fcontent Global rports fChina Honggiao International Al
[E] [ fetecore feontent/Global firparts China Pudong International Airpes
.:l |71 jetecore content fGlobal fArports Denmark fCopenhagen Airport
._'] [ feitecore fcontent, Global /dirports Dominican RepublicPunta Cana I
[E) [ ssitecore/content/Globsl jdirports England fGatwick Arpart

._] [ Jsitecore foontent Elobal fAirports, England London Heathrow Airport
[2) [ fatecorejeontent Global |irports fFrance Paris Charles de Gaule Air
= |} fsitecore jcontent Global fArports Germany Bremen Airport

._'] [ fsitecore foontent Global fArparts fGermany Frankfurt Airport

.:l [ feitecore fcontent, Global fAirports Ttaly Venice Marco Polo

.:l |} fsitecore feontent Global fArpartsJapan MNarita International Airport
[£] [ feitecore eontent/Global jdirparts/Japan Tokys International Airpert u i) Undate
" m ]

@che Al [lun-Check Al [gjCheckabranch g |Un-Checkabranch g Remove O checked items cut of 35

da Version: |

m

[¥] ja-3p  version: |
[] #hcH Wersion: |0

[ <Back | mext> | [ cCaneel
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To remove one or content items from the list, so that you do not send the out for translation, select the
corresponding check boxes in the left page, and click |&/| Remove X checked items out of Y at the bottom
of the list, where X is the number of items that are already selected for removal, and Y is the total number
of items displayed in the list.

Tips: Use the shift key to select a range of adjacent roles or users. Use the Ctrl key to select multiple
non-adjacent roles or users.

Tips: To select all content items in the list, click |#| Check All. To clear the check boxes for all selected
content items in the list, click |E Un-Check All.

Tips about working with branches: To select all the content items in a branch, select one item in that
branch and then click |l&| Check a branch. To clear the check boxes for all selected content items in a
branch, click Un-Check a branch.

To change the target languages and versions to translate, click a content item in the left pane to highlight
it, as shown in the above screen capture. The right pane now displays the target languages set up for the
Connector. Any target languages that you selected earlier, in the Settings page of the wizard, are selected.
You can change this default selection by selecting the check boxes for additional target languages or
clearing the check boxes for selected target languages.

To change the version assigned to the content item, change the version number in the Version box for
the language. If you select Default, the version number is incremented by one.

To save your changes to a target language and version for a content item, click Update at the bottom of
the right pane.

7. When you are done, click Next.

The Translation Options page of the wizard opens.
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| ‘sitecore/shell/defaultaspx?xmlcontrol=CT3_BulkTranslation&itemID=%7b814864CB TIEEFF
Translation Options
Chooss the translation opbons.

Workfiow Option: applied to ALL items selected
[ Assign Translation Waorkflow to items with no workfiow definad?
with state: | Reviewing E

Advanced Translation Options

i Sync Translation
Only send fields with changed content. Unchanged fields will have the original translation automabcally copled to the target version,

Send To Options

Send items to ranslation queus
@ Send items to transiation provider

Send to: IMachine_Translation E
Job Mame
Delrvery Date  12/24/2013 e’
B0 Reference
Description
_' Copy source o target only

8. Inthe Translation Options page of the wizard, you can assign a workflow to items without a workflow, set
the workflow state for the content items you are sending to translation, send only changed content fields for
translation, and decide whether to immediately send the content item out for translation, send it to the
Translation Queue first, or copy the source content to the target version without translating it. You can set
the following options:
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Option

Description

Assign Translation Workflow
to items with no workflow
defined?

You can attach a translation workflow to the content items you send out for
translation, and you can set the workflow state for those items. This is
recommended because it helps manage those items later, especially in the
workbox.

Note: Depending on your company's configuration, you may not be able to
send out content items for translation unless they are attached to a
translation workflow. You can change this configuration with the
ClayTablet.PreventSentingItemsWithoutWorkflow settingin the
CT3Translation.config file. For details, refer to the Clay Tablet
Translation Connector for Sitecore Installation and Configuration Guide.

Note: By default, the translation workflow is the CT3 Sample Workflow.
You can set the default workflow state using the
ClayTablet.StateToAssignInBulkTranslation settinginthe
CT3Translation.config file. For details, refer to the Clay Tablet
Translation Connector for Sitecore Installation and Configuration Guide.

m To assign the translation workflow to any content items without a
workflow assigned, select this check box.

= To proceed with the translation process without assigning a translation
workflow to content items without a workflow, clear this check box.

With state: If you select this check box, you select the workflow state to
apply to all source content items that previously did not have a translation
workflow assigned. For a list and description of workflow states, see page 33.
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Option Description

Sync Translation: Only send |Determines whether to check each field of the source version for any content
fields with changed content. |changes, and send only changed content fields out for translation. If a field
Unchanged fields will have |was previously translated and it has not changed, then the Connector does

the original translation not send it for translation again: Instead, it uses the stored translation.
automatically copied to the When this check box is selected, the Connector sends only changed
target version. content fields out for translation. This may reduce translation costs, but it

increases the processing time before the Connector sends out the items
for translation.

When this check box is cleared, the Connector sends all specified source
content for translation, even if it has not changed since it was previously
sent for translation.

Note: This option may not be available, depending on the setup of the
content item to the attached translation workflow. For details, see the
description of the SynchronizeTranslation feature in "Attaching a Translation
Workflow to an Existing Content Item" on page 24. This option may also not
be available based your company's Connector configuration. For details,
refer to the description of the SynchronizeTranslation setting in the Clay
Tablet Translation Connector for Sitecore Installation and Configuration
Guide.

Note: This option may not be available, based your company's Connector
configuration. For details, refer to the Clay Tablet Translation Connector for
Sitecore Installation and Configuration Guide.

Select one of the following Send To Options:

Send items to translation The Connector sends the content items to the Translation Queue, where a
queue user must approve them to send them out for translation.

Recommendation: Select this option if you want to use the Translation
Queue to batch together many items for translation into many target
languages, but then only immediately send out those items for translation
into a single language.
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Option

Description

Send items to translation
provider

The Connector sends the content items to the Clay Tablet Platform, which
sends it to the translation provider specified in the company's routing rules.
Connector displays additional fields below, where you can specify additional
information.

Note: This option may not be available, depending on your company's
Connector configuration, which may require that all content items are sent to
the Translation Queue for further approval.

Recommendation: Select this option if you need to quickly send out content
and do not need to arrange or filter it, for example, by language.

Send To: If your company has multiple translation providers, and if your
company's Connector configuration enables selecting the translation
provider (instead of using automatic routing rules), you can select the
provider for this item in the dropdown list.

Job Name: Your name for this translation job.

Delivery Date: The requested translation deadline. This is the date when
you expect the translated content to return. By default, it is two weeks
from the current date. To select a different date, either type the delivery
datein the field in MM/DD/YYYY format, or click the arrow and select a
different date in the calendar that opens. This information is sent to the
translation provider as metadata of the translation package.

Note: The default displayed date is based on your company's Connector
configuration.

Recommendation: Discuss with your translation provider whether to use
the information in this field.

PO Reference: The purchase order reference number.
Description: A description of the translation job, including any special
instructions or requests.

Copy source to target only

The Connector copies the source content to the target content item without
sending it out for translation. This is useful in scenarios where there is
content that you do not want to translate, but that you want to include in
the target version. Connector displays an additional field below, where you
specify the job name.

Job Name: Your name for this job.

When you are done, click Next.

The Summary Report page of the wizard opens.

9. Usethe Summary Report page to review the content items you are sending for translation as well as the

target languages, if applicable.
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7 Sttecore - Google Chrome = |[=]
3 B sitecore/shell/defaultaspxTxmlcontrol=CT3_BulkTranslation&itemID=%7b0DE95AE4 -4 1A :‘.'
Summary Report

Al of the follwing items will be sent for ranslation. G

Submitting to Translation Queue:
Translate From: E
English : English

Items for Translation [ Total: 1318 Icem= in cart ]

faitecore/content [V:1] Ta [he-IL]

fsictecors/content/Dealer site [V:1] To [he-IL]

/sicecore/contenc/Dealer aite/Setcings/Spot_links/Left_Image Spot [V:l] To [he-IL)
feitecore/contenc/Dealer aite/Settings/Spot linka/Middle Image Spot [V:1] To [he-IL]
feitecore/content/Dealer aite/Settinga/5Spot linka/Right Image Spot [V:1] To [he=IL]
fsitecore/content/Dealer site/Settings/3pot links/Newa [V:1] Teo [he-IL]
.-"#i!tl‘.‘-::‘t;"¢:.‘4Etﬂtfﬂt&lt:‘_#.‘ttt.-"5#':-:-.1.!1‘."5."Ed:te:f'ﬁﬂn‘.t [Vil] To [he-IL]
;‘SJ.EEC::E_FC:::.cen:;‘nealer_sxte_-"Ee'r_c:.::qsf_fr:n:tex,-’EJ.'r_&map [W:1] To [he-IL]

feitecore/conggng /Dealer aite/SettingalFoozamdiontasy Ua [Vil] To [he-IL
i s . — 2 L
: e B ' =ith 4 £ H
fdicecore/Content/Dealer_site/FiodutcsiNew Producta/SB-900/Hesources "V Ta The-IL)

Jfeicecors/concenc/Dealer site/Produccs/Hew Products/SB-000/Rescurces/Manual [V:1] To [he-IL]
,.-’SJ.l:ec:re,-"c:nten:;ﬂealestlte,-"Ern:l'_'.c:':s,.-‘l:ll:_.'Ital_SLE [V:3] To [he-IL)

/eitecore/content/Dealer aite/Producta/Digital SLR/D3X [V:1] To [he-IL]

fsitecore/content/Dealer site/Products/Digital SLR/D3X/Resources [V:1] To [he-IL] -

| <Back | submit> | [ cCancel

Click Submit to send the content items to the next step, which you specified earlier in the Translation
Options page of the wizard.

The final page of the wizard opens, displaying the following information:

The number of content items sent out for translation, to the Translation Queue, or copied over to the
target version without translation.

Whether the items were sent out for translation, to the Translation Queue, or copied over to the target
version without translation.

Important: If the Connector sent the items to the Translation Queue, you must approve them there to
send them out for translation. For detailed instructions, see "Submitting Content for Translation from the
Translation Queue" on page 60.

Alist of all content items, including their paths, that the Connector sent out for translation, to the
Translation Queue or copied over to the target version without translation.
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€ ==

core/shell/defaultaspx?xmlcontrol=CT3_BulkTranslation&itemID :;7:_-3-_'-5'.-"'-:F—":’:::'F |
* The Bulk Translation wizard has completed. Click Finish to close the wizard.
Copying a total of 35 items to target language(z):
& Ttem Source -
[£] 1 jsitecore fcontent/Global jAirports fAustraliaMelbourne Airport en[vil]
[2] 2 jsitecore fcontent/GlobaljAirports Australia/Sydney Kingsford Smith Arpart en[vil]
[£] 3 /sitecore fcontent/Global jAirports Belgium Brussals Arpart en[vil]
[£) 4 jsitecorejcontent Global fAirports Canada Toronto Pearson International Alrport en[V:1]|g
[£) 5 [sitecore foontent Global fAirportsChina Beiing Capital International Arport en[V:il]
(2] & [sitecore jcontent Global (Airports fChina Hong Kong International Arpart en[V:i1]
[2) 7 jsitecorejcontent Global firports fChina Hongagiao International Airport en[V:i1]
)& sitecore fcontent Global fAirportsChina Pudong International Ainport en[V:i1]
)% [sitecore fcontent Global fAirports/Denmark/Copenhagen Airport en[V:1]
|=) 10 sitecore fcontent Global fAirportsDomirican Republc/Punta Cana International Airport en[Vil]
|=) 11 sitecorefcontent/Global (Airports England /Gatwick Arpart en[Vil]
[£] 12 /sitecore fcontent/Global fAirports/England London Heathrow Alnport en[Vil]
[£] 13 jsitecore fcontent Global jAirports France Paris Charles de Gaulle Airport en[Vil]
[£] 14 jsitecore fcontent Global jAirports Germany Bremen Anpart en[vil]
[£) 15 sitecore fcontent Global fAirports fSermany Frankfurt Alnport en[V:il]
[£) 16 jsitecore foontent Global fAirports,Ttaly Vence Marco Polo en [wil] _
4 g - 15} i i

Sending job ‘My Job'. It is safe to close the wizard at any time, the job will be sent in background.

Items to send Preparng Sendng Sent to OTT In Translaton Reoeived Completed
) Mumber of items: 35 a ws a a q 0

Preparing job details... [ 1

If you sent the content items to a translation provider, or copied the source content to the target, the Job
Progress box is displayed at the bottom of the page, indicating the Connector's progress in sending out the
items for translation or copying over the content. The Number of Items refers to the number of content
items in the source language. In the other columns, each target language represents an item.

10. Click Finish to close the wizard. The processing and sending continues in the background.

4.4.1 Adding a Source Filter when Sending Multiple Items for Translation

The Select an Account dialog box opens when you click the Add button in the Created by filter section or the
Updated by filter section in the Specify Source Filters page of the Bulk Translation wizard.
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4.4 Sending Multiple Content Items for Translation

You use this dialog box to create a filter for sending bulk content for translation based on roles or individual
users who created or updated the content items.

| 7 Sitecore - Google Chrome

Select an Account

Select & roks or 8 user.

Account Type
2 Roles
Users

Role

sitecoreAnalybos Reporting
sitecore\Approval
Htecore | Author
sitecore Bilag Editor
sitecore\Calendar Administrator
sitecore\Designer
sitecore\Developer

sitecore\Full Editing and Designing
sitecore Minmal

sitecore Micam Custom Autharing
sitecore|Page Editor Limited
sitecore \RestrictedEditor

stecore\Sitecore Chent Authoring
sitecore\Sitecore Chent Configuring

16 fsitecore,/sn

sitecore\Gitecore Clent Actount Managing

elly

By default, this window displays all roles. By default, the items in the list are displayed in alphabetical order.

To display users instead of roles, click Users in the Account Type box at the topic of the window.

Roles are displayed in alphabetical order.

If users are displayed, they are displayed in alphabetical order.

You select the roles for the filter. For example, if you are creating a filter to include only content created by users
assigned to certain roles, you select these roles.

Tips: Use the shift key to select a range of adjacent roles or users. Use the Ctr1 key to select multiple non-

adjacent roles or users.

For information about navigating the pages in the list, see "Navigating Pages in a List" on page 14.

When you are done, click OK.
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4.5 Submitting Content for Translation from the Translation Queue
You submit content for translation from the Translation Queue in the following scenarios:

= When you reviewed content, you submitted it to the Translation Queue, by selecting the Send items to
translation queue radio button, instead of immediately sending it for translation, as described in the
previous sections:

# "Submitting a Content Item for Translation using the Content Editor" on page 34
# "Submitting Content for Translation from the Page Editor" on page 39.
# "Sending Multiple Content Items for Translation" on page 44

= Your company is configured to always submit content items to the Translation Queue before sending them
out for translation.

Submitting content to the Translation Queue before sending it out for translation has the following advantages:

= You may not want to send out each content item individually as soon as you finish reviewing it. The
Translation Queue facilitates your management of reviewed content, so that you do not forget about
sending individual reviewed content items for translation.

® Your translation provider may prefer receiving fewer but larger batches of content to translated, rather than
individual content items, as it facilitates project preparation, resource assignment, and file analysis.

® Ifyou want to translate many items into multiple languages, but you want to translate into only one target
language at a time, this is a good way to manage that process.

If you or your colleagues have added content items to the Translation Queue, you must access it and approve
the files you want to send out.

Note: If you do not approve content items in the Translation Queue, the Connector does not send them out for
translation.

When you send content for translation from the Translation Queue, you can add project metadata, including a
project name and a requested delivery date, when the translations will be returned.

Note: These instructions assume you already have content items in the Translation Queue. For information on
submitting content to the Translation Queue, see "Submitting a Content Item for Translation using the Content
Editor" on page 34.

To submit one or more content items from the Translation Queue for translation:
1. Do one of the following to open the Translation Queue:

In the Sitecore Content Editor ribbon, click the CT3 Translation tab, and then in the Translation Tools
section, click Translation Queue.
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In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CT3 Translation >
Translation Queue from the menu.

The Translation Queue opens.

If you use the Sitecore Content Editor, it opens in a separate browser window.

If you use the Sitecore Desktop, it opens in the same browser window.

Translation Queue

——

Item Path Database Lamguage Wersion Translate To Deadims Creatad

JoontentMicamProducts _CTDema Digital_SLR Easy_to_useD-4/... master &n 1 daDIE es-ES fr-FRLt-IT ja-.. 07/10/2013 06 26/2013 91
JcantentMicamProducts_CTDemo Digital_SLR Easy_to_use/D40/... master &N 1 eI 11/08/2013 10252013 13
feantentMicam Products_CTDema Digital_SLR Easy_to_use/D40/.. masker & 1 e £5 es-PA Yes  10/29/2013 10152013 %
Jfeontent/Micam Products_CTDemoDigital_SLR/Easy_to_use/D40/.. master en 1 da,de-DE es-£5, fr-FR, fi-FI 05/17/2013 05032013 7B
feonteniMicamProducts_CTDemo Digital _SLR/Easy_to_use/D40/..  master en 1 deDE,es-E5esPA 07/01/2013 06172013 £
JoontentMicamProducts _CTDema,Digital_SLR Easy_to_useD4f... master &N 1 de-DE w5-ES, fr-FRit-IT ja-. . 037132013  02/27/2013 91
JoontentMicamProducts_CTDema, Digital_SLA.Easy_to_use/040/... master en 1 de-DE es-E5,fr-FRAFes .. 03/12/2013  02/25/2013 a5
JeantentMicam Products_CTDemo Digital_SLR Easy_to_use/D40/.. master & 1 fr-FR,ja-1P 08/30/2013  08/16/2013 %
JeomtentNicam Products_CTDemo Digital_SLR,Easy_to_use/D40/... master en 1 da Yes  11/20/2013  11/06/2013 13
JfeantentMicamProducts_CTDemo Digital_SLAEasy_to_use/D40/.. master en 1 da deDE es €5, FR.AFL. Yes 08/26/2013 08122013 78
JoontentMicamProducts _CTDemo,Digital_SLR Easy_to_use/D<4/... master &n 1 esES, fr-FR, zhC,it-IT ja-.. 08/26/2013  08/12/2013 65
JoontentMicamProducts_CTDema,Digital_SLR.Easy_to_use/D40/... master en 1 de-DE,es-E5 esf4 05/06/2013  O4/22/2013 k)
JoontentMicamProducts_CTDemao Digital_SLR Easy_to_use/D40f... master &N 1 de-DF e3-£5 esPA Yes  06/05/2013  05/22/2013 )
JeontentMicam Products_CTDemo Digital_SLR Easy_to_use/D40/.. master &n 1 de0F e5-E5 e P4 09/02/2013  08/13/2013 I=
feantentMicamProducts_CTDemo Digital_SLA/Easy_to_use/D40/.. mester &n 1 de-DE, e5-E5 05/20/2013  OSM&/2013 26

I L T » rl Page 1of 47 (95 items)

The top of the window displays the total number of estimated words in all the content items in the queue.

The window displays the following information about the content items in the queue:

Column |[Description

ltem The path and name of the content item.
Path

Database [The database that stores this content item.

Language [The language code of the source language of the content item to send for translation.

Version |The version of the content item to send for translation.
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Column |[Description

Translate |The language codes of the target languages into which to translate the content item.
To

Sync Indicates whether the Optimize Translation feature is enabled for this content item. This feature
sends only changed content fields out for translation, which reduces translation costs.

= If this column has a value of Yes, then this feature is enabled for this content item.

m If this column is blank, then this feature is not enabled for this content item.

Deadline |The requested date for received the translated content back from the translation provider, in
MM/DD/YYYY format.

Created |The date when the source content item was created, in MM/DD/YYYY format.

Words The number of words in the content item.

2. Do one of the following:
# Select one or more content items to send for translation, and click Send Selected.

Tips: Use the shift key to select a range of adjacent items. Use the Ctr1 key to select multiple non-
adjacent items.

@ Click Send All.

The Send Items Out for Translation dialog box opens.
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I ¥ Sitecore - Google Chrome - O x
| /sitecore/shell/default.aspx?xmlcontrol=CT3_Senditems&items=b5f5c82e-968e-4690-b4df-7d38bd392e5c%7odabede [F
'==| Send Items out for Translation
= | send Sitecore items cul for transation
@ Sendng 12 item(s) for translation to:  Machine_Translation |Z| () Copy 12 item(s) from source to target language
Jab Mame
Delivery Date 12/24/2013 A |
PO Reference
Description
12 items to send (estmated words: 15) Remave > | < Add 26 more [tems in queue
Item Langual Item Lamg »
_‘l [sitecore fcontent/Global fairpor ts/Australia/Sydney Kingsford Smith Airport en[1] u foontentfGlobal/Airports Unibed States George Bush Intercontnental Airport en[;
[5) fsitecore content/Global fCarouses Home Page en[1] | (2] feontent/Global/Airports/France [Paris Charles de Gaulle Airport en[:
_‘l fsitecorefcontent Global fRirpor ts/Poland Poznan Lawaca Airport en[1] u foontent/Global/Airports Belgum Brussels Airport enl]
[£] /sitecore content Global fAirpor ts Me therlands/ Amsterdam Airport Schiphol en[1] | [E) feontent/Global/Airparts Denmark Copenhagen Arport en[:
J fsitecone foontentGlobal fAirpor ts/Switzerland Zurich Arpart en[1] u foontent/Global/Airports Unibed States Logan International Arport en[i|s
[£] /sitecore fcontentHome Plan And Book Destinations/Hawai enf1] | =) feontent Global/Airports/England Gatwick Aiport enl!
) fsitecore fcontent/GlobalfRirpertsMNew Zealand fAudkand Airport en[1] | (5] feontent/Global/airports Singapare/Singapore Changi Airport en[:
J [sitecore fcontent/Glabal f8irpor ts/England London Heathrow Arport enf1] u feontent/Global /Rirports Japan,Marita International Airport el
) fsitecone fcontent/Globalfairperts China /Pudang International Arpart en[1] | [£) feontent/Global/CarauselsfHome Page Caribbean en[:
J [sitecons foontent Global fAirports/United States/Dalas Fort Werth Intemational Arport  en[1] u feontent/Global/Airports United States/San Francisco International Airport enll
] fsitecore fcontent GlobalfAirpor ts/Deminican Republic/Punta Cana International Airport  en[1] | () feontent/Global/Airparts Anited StatesManchester Boston Regional Airport en[:
J [sitecore fcontent Global fairper ts /Canada Toronts Pearson Internationsl Arport en[1] u feontent Global /Rirports Ttaly Verice Marco Polo enl!
(<) feontent/Global/Airparts/Japan Tokyo International Airpart e
u feonvtant Global/Rirparts United States Oohn F Kennedy Internationsl Airport enf!
) feontent/GlobalAirportsUnited States/Los Angeles International Airport el
] feomtentGlobal Airports China/Hong Kong Tnternational Arpart en[; *
L) m ( 4 Lal} ¥
Ol Canoel

The items you selected to send are in the items to send pane on the left. If you did not select all the items in
the queue, then the items you did not select are in the items in queue pane on the right.

3. Choose one of the following:

To send the selected items to your translation provider, select Sending X items for translation to, where
X is the number of selected items. If your company has multiple translation providers, and if your
company's Connector configuration enables selecting the translation provider (instead of using automatic
routing rules), you can select the provider for this project in the Send item(s) to dropdown list.

Enter the following information about the project in the fields at the top:

Option Description

Job Name (Your name for this translation job.

Clay Tablet Translation Connector for Sitecore User Guide Page 63
Version 3.6.2 February 25, 2014



4 Sending Content to Translation 4.5 Submitting Content for Translation from the Translation Queue

Option Description

Delivery The requested translation deadline. This is the date when you expect the translated
Date content to return. By default, it is two weeks from the current date. To select a different

date, either type the delivery date in the field in MM/DD/YYYY format, or click the arrow and
select a different date in the calendar that opens.

This information is sent to the translation provider as metadata of the translation package.
Note: The default displayed date is based on your company's Connector configuration.

Recommendation: Discuss with your translation provider whether to use the information
in this field.

PO The purchase order reference number.
Reference

Description [A description of the translation job, including any special instructions or requests.

This information is delivered to your translation provider along with the content items for translation.

z To copy over the selected items to the target version, without translating them, select Copy X items from
source to target language, where X is the number of selected items.

4. Optional. To add other items to your project, select them in the more items in queue pane on the right and
click Add.

Note: To remove items from your project, select them in the items to send pane on the left and click
Remove.

5. To send theitems for translation or copy the source to the target, without translation, click OK.

The Job Progress box opens, indicating the Connector's progress in sending out the items for translation or
copying over the content. Each target language represents an item.

._.u Stecore - Google Chrome I

==| Job Progress

Send Sitecore items out for tranation

Sending job "My Job'. It is safe to cdlose the wizard at any time, the job will be sent in background.

# Preparing Sending Sent to CTT In Translation Received Completed
=] Mumier of items: 0 15 0 o 0 31

Processing prepared translabon items (en->fr#R): 8/11...

Waiting for 66.207.215.102.,
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6. Click Close at any time to close the Job Progress box. The processing and sending continues in the
background.

Tip: To monitor the translation progress, In the Translation Tools section of the CT3 Translation tab, click
Translation Status. For detailed instructions, see "Monitoring Translation Status" on page 66.
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5 Monitoring Translation Status

You can track the status of your translation projects from within the Content Editor, from the CT3 Translation
tab on theribbon. There are three ways to monitor the translation status:

m View the status summary, as described on page 67.
= View the status of a single item, as described on page 72.
= View the status for all in your project, as described on page 68.

For a list and description of translation statuses, see "Translation Statuses" on page 66.

5.1 Translation Statuses

Content items have one of the following translation statuses:

. Percentage

Translation L. .
Description Translation

Status

Complete

[In Queue] The Connector sent the item to the Translation Queue. It must be 0%

Wait for approved in the queue before the Connector sends it out for translation.

approval

Preparing The Connector is preparing to send out the item to the translation 1%
provider.

Sending The Connector is preparing to send out the item to the translation n/a
provider.

Sent to CTT The Connector is preparing to send out the item to the translation 2%
provider.

In The Connector sent out the item to the translation provider, who has not 10%

Translation yet returned the translated item.

Received The Connector received the translated item back from the translation 90%
provider.

Completed The Connector has returned the translated item to Sitecore. 100%
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i Percentage

Translation L. .

Description Translation
Status

Complete

No field to There are no fields to translate in the content item. (The fields may have 100%
translate been excluded by the Translation Filter or the filter in the Bulk Translation

wizard.)

5.2 Viewing Your Translation Status Summary

You can view a summary of the translation status of all content items in this Sitecore instance.

b To view this summary, on the Sitecore Content Editor ribbon, click the CT3 Translation tab. The summary is
displayed on the Translation Statuses section of CT3 Translation tab.

H | L) Bulk Tranciation .2} Trandiation Queue... g.f. Clear backup data Sentwm CTT1 11
SenmlSP: &
Save || |_:| Translaton Fiter ) Translation Status  #) Item Translation Details
The following information is displayed about your content items:
Percentage
Information Description Translation
Complete
In Queue The number of content items in the Translation Queue. 0%
Preparing The number of content items that the Connector is preparing 1%
to sent to the Clay Tablet Platform.
Sending The number of content items that the Connector is currently n/a
sending to the Clay Tablet Platform.
Sentto CTT The number of content items that the Connector sent to the 2%
Clay Tablet Platform, which is currently preparing to send
them out for translation.
Sent to LSP The number of content items that the translation vendor has 5%
received to translate.
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5.3 Monitoring Status for Multiple ltems

Percentage
Information Description Translation
Complete
In Translation The number of content items that the translation vendor has 10%
received to translate.
Received The number of translated content items that the Connector 90%
has received back from the translation provider.
Completed The number of translated content items that the Connector 100%
has returned to Sitecore.
Jobs The number of translation jobs that the Connector has sent n/a
out for translation. Ajob includes one or more content items.
Backup Translations The number of content items for which the translations are n/a
backed up.
Backup Projects The number of backed up-translation projects. Information n/a
about content items in backed up-translation projects is not
included in the other fields of the Translation Statuses section
of the CT3 Translation tab.
CTT Log Files The number of CTT log files that are in the $ (dataFolder) n/a
/Logs/ folder.

5.3 Monitoring Status for Multiple Items

You can view the translation status of multiple content items from either the Sitecore Content Editor or the
Sitecore Desktop.

I Do one of the following to open the Translation Status window:

In the Sitecore Content Editor ribbon, click the CT3 Translation tab, and then in the Translation Tools
section, click Translation Status.

o Home Mavigale REview Andyre Publish

gt 1o CTTh 11 Recerved: O

SeancwlSP: & Compsoad:
Tn Tennslation: 2 Jotbes: 44

Bacioup Transiations: 29
Backup Projerm: 0
CTT Lo Files: 1

H ) Bulk Translation ) Translation Queue ¢ J Clear backup data
save | || Translation Fitter E]Itam‘l'mﬂaﬁmbelals
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In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CT3 Translation >
Translation Status from the menu.

The Translation Status window opens, displaying the translation status of all content items.
If you use the Sitecore Content Editor, it opens in a separate browser window.
If you use the Sitecore Desktop, it opens in the same browser window.

By default, the content items are sorted by path. For information on changing the sort order and other
features when working with lists, see page 13.

I ¥ Sitecore - Google Chrome - |0 x
[ fen/sitecore/shell/sitecore/content/Applications/ClayTablet3%:20CT3/Translation%205tatus.aspx '
—_— ke — ALL — x| 9
= Stanus | — ALL — -

COpen Selected ltems Refresh

Mews  fAe o |/Vew

ItemPath Language  Version Type Status Percent Created Undated
Jeantent/Micam/Products_CTDemo/Digital_SLREasy_to... nb-NO 1 Mew Transkation Completed  TIEPEEEEE  04/09/2013  04/0%/2013
jcontentMNicamSroducts_CTDema,Digital_SLR/Easy_to..  nb-ND 1 Mew Translation Completed ~ TGCHEEEE  04/09/2013  04/09/2013
Jcontent/MNcamEroducts_CTDemo Digital_SLREasy_to..  fifl 1 Mew Translation Completed ~ MECEEEEE  04/09/2013  04/09/2013
feontentMcamBroducts_CTDemo /Digital_SLR/Ful_fest.. es£5 24 Mew Translation Completed  MTOEEEEE  02/27/2013  02/27/2013
feontent MicamProducts_CTDemo Digital_SLR/Ful_feat, . h-CN 2 Mew Transletion Completed RPN 02/77/2013  02/27/2013
Jeantent/MicamProducts_CTDemo/Digital_SLRFul_feat. . fr-FR 19 Mew Translation Completed  MEPEEEEE  02/27/2013  02/27/2013
foontent/MicamProducts_CTDemo,Digital_SLR/Ful_feat. . de-DE 21 Mew Translation Completed  METEEEEE  02/27/2013  02/27/2013
Jcontent/MNicamSroducts_CTDema,Digital_SLRFull_feat. . it-IT 9 Mew Translation Completed ~ MECHEEEE  o2/27/2013  02/27/2013
Jcontent/McamSroducts_CTDemaDigital_SLA/Easy_to..  ja-IP 2 Mew Translation Completed  MECEEEEE  09/03/2013  09/03/2013
JfeortentMicamProducts_CTDemo Digital_SLA/Easy o,  itIT 1 Mew Translation Completed  MGOWEEEE  03/16/2013  08/16/2013
JeontentMecsm Products_CTDemo/Digitsl_SLR Eesy_to..  ja-IP 1 Mew Translstion Completed MG  05/16/2013  08/16/2013
feontent/MicamMy_Micam My _Blog de-DE 1 Mew Translation Completed ETEEEEE  09/25/2013  09/25/2013
Jcontent/Micam My _Hicam My _Blog da 2 Mew Translation Completed ~ TGCHEEEE  09/25/2013  09/25/2013
Jcontent/MicamSroducts_CTDema,Digital_SLR/Easy_to.. zh-CN 3 Mew Translation Completed ~ MGCHEEEE  10/15/2013  10/15/2013
JcontentMcamBroducts CTDemo,Digital_SLA/Easy to...  ja-IP 4 Mew Translation Completed M  04/22/2013  04/22/2013

14 4 i} Ly M Page 1 of 14 (206 items)
The following information is displayed about each content item in the list:

Column Description

[temPath The path and name of the content item.

Language | Thetarget Connector language code for the content item.

Version The incremental version number of the source content item.
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Column Description

Type This is one of the following:
® New Translation:new translation requested.
B Fix Translation:translation correction requested.
B Sync Translation:requestto synchronize translation with other target languages.
®m Copy to Target:source content copied to target without translation.

Status For a list and description of translation statuses, see page 66.

Percent The percentage of the content item that has been translated, which is based on the
translation status. For details, see page 66.

Created The date the content item was created, in MM/DD/YYYY format.

Updated The date the content item was updated, in MM/DD/YYYY format.

Actions

You can perform the following actions in the Translation Status window:

k To display only content items for a particular translation job, select the job from the Job dropdown list and
click Refresh.

I To display only content items with a particular translation status, select the status from the Status dropdown
list and click Refresh.

+ To view one or more content items, select them, and click Open Selected Items. Each content item opens in
the Content tab in a separate browser window.

If the translation has Completed status, the Content tab displays the translated version.

If the translation has Sent to CTT status (for a correction request), the Content tab displays the
translated version.

# Otherwise, the Content tab displays the source version.

b To refresh the list of content items in the window based on a new selection in the Job or Status filters, or
newly created content items, click Refresh.

b To navigate to another page in the list, click a button in the navigation bar below the list. For detailed
instructions, see page 14.
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b To group content items by a column, click the column heading. While you hold down the cursor, drag the
column heading to the Drag a column to this area to group by it area above the list on the left. For details,
see page 71.

F To search for one or more content items in the list, enter the search criteria in the Search box in the top right
corner of the list, and press Enter. The Connector searches all columns and displays only items that match
the search criteria.

5.3.1 Grouping Content Items by Column in the Translation Status window

In the Translation Status window, you can group the items in the Translation Status window by one of the
columns. For example, suppose that you want to group the content items by the Status column.

1. Click the column heading. For example, click the Status column heading.

ItemPath Version Language Tyvpe St Percent Created Lpdated

foontent/Micam ProductsLensesMacrof 105mm_f_2_8G6... 1 frFR Mew Translation CEIEE:\::I T 10/07/2013  10/07/2013
Jcontent/Micam ProductsLenses Teka600mm_f_4D_ED-.. 1 frFRL Mew Translation Completed MW  10/07/2013 10/07/2013
Jeontent/Micam ProductsLenses Teke /70-200mm_f 2 & . 1 frFa Mew Translation Mo field to .. MEEEEEEE  10/07/2013 10/07/2013
JeontentMicam Products Lenses Macra/60mm F 2 86_ 1 frFRL Mew Translation Completed MU 10/07/2013 10/07/2013
JeantentMcam Products Lenses Macra/105mm_f_2 8G... 1 fr-FR Nesw Translation Completed ML 10/07/2013 10072013
Jeontent/Nicam Products Lenses/\Wide14mm_f 2 8D E.. 1 frFR. Mew Transistion Completed NN  10/07/2013  10/07/2013
Jeontent/Micam ProductsLenses Mormal 1 frFR Mew Transiation Completed  FUCNENEEN  10/07/2013  10/07/2013
JcontentMicam ProductsLenses Tele/70-200mm_f_2 8. 1 frFR e Translation Completed MW 10072013  10/07/2013
JcontentMicamProductsLenses \Wide/14-24mm _f 2 8. 1 frFe Mew Translation Completed MW 10072013  10/07/2013
feontentMicam ProductsLenses Macrofs0mm f 2 86_ 1 frFA Mew Translation Mofeldto . MIEWEEEE 10072013  10/07/2013
Jeontent Micam Products Lenses Tele 70-200mm_f 2 B, 1 frFR Mew Translstion Completed MRS 10/07{2013 10/07/2013
JeantentMicam Products LensesWide 14mm_f 2 8D E.. 1 frFR Mew Translation Nofieldto .. IS  10/07/2013  10/07/2013
JeontentMicam Products Lenses MacroS0mm _f_2 8G_ . 2 frFR Mew Translation Completed TGN 10/07/2013 10/07/2013
fcontentMcamProducts Lenses Normal 24-Mmm_f_2__. 1 fr-FR Mew Translation Completed ioss | 10/07/2013 10072013
JcontentMcamProducts Lenses Mormal S0mm_f_1 4D 1 fr-FR Mew Translation to field to .. 10/07/2013 10/072013

2. While you hold down the cursor, drag the column heading to the Drag a column to this area to group by it
area above the list on the left.

This list items are grouped by the column you dragged.

[temPath Version  Language Type Status Percent Created Updated
] States: Completed

[ Status: No field to randate

(H Statuws: Complated
[H Status: Mo fisld to trarsate
|4 Starhus: Completed

3. Click an Expand button = to view the items in each column group.
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ItemPath Version  Language Type Status Percent Created Updated
;‘] Staths: Completed

feontent Micam Products Lenses Macro/105mm_f 2 8. 1 frFR Mew Translation  Coenpleted [N 10/07/2013 100772013

feortentMicam Products Lerses Tele 600mm_f 9D E. 1 frFR New Translstion  Completed MW  10/07/2013  10/07/2013
=2 Status: Mo fisld to randate

fcontentMicam Products Lenses Tele/70-200mm_f 2_ 1 frF Wew Translation Mo field to . (W 10/07/2013  10/07/2013
=) Status: Completed

feontentMicam Products Lenses Macro/s0mm_f_2_BG.. 1 fr 7 Mew Translation  Completed TN 0/07/2013  10/07/2013

fcontentMicam Products Lenses Macro/105mm_f 2 8. 1 frFR Mew Translation  Completed [N 10/07/2013  10/07/2013

jcontent/Micam Products LensesWide/14mm_f_2 8D 1 frFa New Translaton  Completed [TECEEEEE  10/07/2013  10/07/2013

fcontent Micam Products Lenses MNormal 1 frFa New Translation  Completed [CEEEEE  10/07/2013  10/07/2013

feontent Micam Products Lenses Tele/70-200mm_f 2 .. 1 fr-FR Mew Translation  Completed (RGN 10/07/2013  10/07/2013

feontent Micam Products [Lenses Wide/14-24mm_f_2_ .. 1 frFR Mew Translation  Completed TELTWENE  10/07/2013  10/07/2013
= States: Mo field o randate

fcontent Micam Products JLenses Macroj§0mm_f_2_BE.. 1 frF Mew Translation Mo fied to .. (W 10/07/2013  10/07/2013
\=l Status: Completed

jeontent Micam Products Lenses Tele/70-200mm _f 2_.. 1 frFR New Trangdation  Completed MEPNEEEE  10/07/2013  10/07/2013

For a detailed description of the Translation Status window, see "Monitoring Status for Multiple Items" on
page 68.

5.4 Monitoring Status for a Single Item

You can view the translation status of a single content item, or of a group of content items under a common
root folder.

1. Navigate to the content item whose translation status you want to check.
2. In the Sitecore Content Editor ribbon, click the CT3 Translation tab.

3. Inthe Translation Tools section, click tem Translation Details.

The Translation Status tab for the content item opens.
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5.4 Monitoring Status for a Single Item

e Target
de-DE, es-ES, fr FR,it-IT ja-20 fiF1,es-PA
da, de-DE,es-ES, fr-FR fiFl,es-PA

de-DE es-ES es-PA

de-0E es-E5, fr FR,fi-Fl esPA
de-DE,es-ES, fr FR,it-IT ja-JP fiFlesPa

frFR,ja-P

da,de-DE,es-ES,fr-FR,AFLes-PA
es-E5,fr-FR, zh LN, it-IT ja-P
de-DE,es-E5,es-PA

-DE e5-ES, es-PA

Oe-OE es-E5 e5-PA

zh=CN
de-DE,es€5

es-E5,fr-FR,fiFles-PA

£ Vi)
jalP Vi1
esPa [
it=IT [V:2)

esES [v:9]
frFR [v:6]

1] frFR V7]

5

ranslated Transation status Lastipds
[In Quewe] Wait for approval /26

Created

6/26/2013 10:06: 18 AM
£/3/2013 10:30:27 AM
6f17/2013 12:08:48 PM
2/26/2013 2:55:02 PM
2/27/2013 2:48:54 PM
3 X51:11PM

[In Quese] Wait for approval
[In Quewse] Wait for approval L
[In Queuse] Wait for approval 226/
[In Quexse] Wait for approval  2/27/.
[In Quewe] Wait for approval

B/12/2013 11:47:44 AM

I Queus] Wait for approval  8/12/7
01 [In Quesse] Wait for approval
4/22/2013 6:10:03 AM

5/22/2013 11:01:47 AM

[In Quese] Wait for approval
[In Quewse] Wait for approval

iiiiﬁiiﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁﬁ

2:17:09 PM [In Queue] Wiait for approval  8/19/
13 1:31:58 PM (In Quese] Wait for approval
47:35 AM [In Quewe] Wait for approval
13 1:51: 10 PM I Queus] Wait for approval
13 10:25:56 AM Completed
13 10:25:56 AM Completed
13 10:35:58 AM Completed
13 10:25:56 AM Completed
13 10:25:56 AM Completed
13 10:25:56 AM Completed
8/30/2013 2:48:56 PM Completed

) Bulk Transiation ) Translation Queue g Clear backup data MM:* ::g; Racaivads :,.
Save || Li] Translaton Fiter ) Transiation Status  #] Ttem Translation Detais | Sonding: 0 Trasineg 0 Sabar %
NP Content § [#] Translation Status %
= [ sitecore D Refresh
= ) Content Ttem
& & Dealer site [2) feontent icam Products_CTDems/Digital_SLR/Easy_to_use/D40/Resources/Software
= &) hicam [) feantent Micam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software
G settings [2) feantent Nicam Products_CTDems,Digital_SLR/Easy_to_use/D40/Resources/Software
2] view semple Ttem [2) frontent/hicam Products_CTDema/Digial_SLR/Easy_to_use/D40/Resources/Software:
# gl Products 2} eontent/Hicam Products_CThemo/Digital_SLR/Esy_to_use/040/Resources Software
= ?ﬁg:;:?'“ [2) feantent Micam Proccts_CToemo/Dicital_SLR/Ezsy_to_use/040 Resources /Sofware
S W Ful featured [2) feantent Hicam Products_CTDems/Digital_SLR Easy_to_use/D40/Resources/Software:
= 3 Easy touse [2) feantent Hicam Products_CTDems/Digital_SLR Easy_to_use/D40/Resaurces/Software
% M@os [) feantent Micam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software
= [@ow [2) feantent Nicam Products_CTDems,Digital_SLR/Easy_to_use/D40/Resources/Software
= N Resources :] feontent/Nicam Products_CTDemo/Digital_SLR Easy_to_use,D40 Resources/Software
£ FAg [2) feontent/Micam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software
4 seftware] | [3) feantent/Nicam Products_CThemo/Digital_SLR/Easy_ta_use/540/Resaurces/Saftware
[} Amazing Imagery [2) feantent Hicam Products_CTDems/Digital_SLR Easy_to_use/D40/Resources/Software:
H g My _Micam @ feantent/Nicam Products_CThema Digital_SLA Easy_to_use/D40 Resources/Sofware
H I Community & feantent Nicam Products_CTDemaDigital_SLR Easy_to_use/D40 ResourcesSoftware
# flsx &) foontent Nicam Products_CTDems/Digital_SLA/Easy_to_use /D40 Resources/Software
* il support 0 feontent/Nicam Products_CTDemo/Digital_SLR Easy_to_use,D40 Resources/Software
# i Articles & foontent/Micam Products_CThemaDigital_SLR Easy_to_use/D40/Resources/Software
& i@ Company & foontentMicam Products_CThema Digital_SLR Easy_to_use/D40 Resaurces/Software
& Globals & foontent/Micam Products_CTDema Digital_SLR/Easy_to_use/D40 Resources/Software
B JRsS Feeds - =
5 & Calerclar Evurty ,  ||Total Transiations: 21

This tab displays the following translation-status information about the selected content item and any child

items:

Note: The Translation tab is blank if either the content item has not been sent for translation, or it was sent

to the Translation Queue, and then it was removed from the queue.

Column Description
Item This is the item path and name. The preceding icon indicates the translation status, as
described below:
[ One of the following statuses: Completed; No field to translate.
= [J] All other statuses.
For a list and description of translation statuses, see page 66.
Source The I1SO code of the source language and the version number of the source content. For

example, if this content item is in English, and it is the first version, thisisen [V:1].

Target

The regional ISO code of the target language and the version number of the target

content. For example, if this content item is in Japanese, and it is the first version, this is
ja-Jp [V:1].
Note: If there are multiple translation targets, then multiple regional ISO codes and
version numbers are displayed.

Created The date and time when the content item was created, in the following
format: MM/DD/YYYY HH:MM:SS.
Translated A percentage indicating how much of the content item has been translated. This is based
on the translation status, which is described in "Translation Statuses" on page 66.
Translation For a list and description of translation statuses, see page 66.
Status
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Column Description

Last Update The date and time when the content item was last updated, in the following
format: MM/DD/YYYY HH:MM:SS.

TNS Type Translation type. This is one of the following:

B New Translation:new translation requested.

B Fix Translation:translation correction requested.

® Sync Translation:requestto synchronize translation with other target languages.
B Copy to Target:source content copied to target without translation.

B Queued Translation:contentisin Translation Queue.

TNS Backup Indicates whether the translation of the content item is backed up in the database. It has
one of the following values:

= Yes

= No

Note: This is determined by the ClayTablet.BackupTranslationData settingin the
CT3Translation.config file. For details, refer to the Clay Tablet Translation Connector
for Sitecore Installation and Configuration Guide.

Reference The regional ISO language code and version of an item.

m Foran item that has not been sent out for translation yet, for example, an item in the
Translation Queue, it refers to the source language and version of the item that will be
translated.

= For an item that has already been sent out for translation, it refers to the target
language and version.

Actions
When you are viewing the translation status, you can also perform the following actions:

[5
b To refresh the translation status information for the content items in the list, click the Refresh button at
the top of the tab.

+ To remove a content item from the Translation Queue, so that the Connector will not send it for translation,
select it, right-click, and select Remove from the Translation Queue from the context menu. Available only
for items that have not been translated yet and are in the Translation Queue, with [In Queue] Wait for
approval or Sent to CTT status.

k' To approve a content item for translation in the Translation Queue, so that the Connector will send it for
translation, select it, right-click, and select Approve this queue item for translation from the context menu.
Available only for items that have not been translated yet and are in the Translation Queue, with [In
Queue] Wait for approvalorSent to CTT status.

I To update a remote TM (translation memory) with source content that was edited after it was sent for
translation, select it, right-click, and select Send post-edited content to Update a remote TM from the
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context menu. Available only for items that have already been translated, with Completed status. For
details, see "Updating a Remote TM Server" on page 84.

b To request a correction of translated content, select the corresponding source content item, right-click, and
select Request Translation Correction from the context menu. Available only for items that have already
been translated, with Completed status. For details, see "Requesting Translation Correction" on page 81.

I To update additional target languages to match the updated translated content, select the corresponding
source content item, right-click, and select Synchronize Translated Versions from the context menu.
Available only for items that have already been translated, with Completed status. For detailed instructions,
see "Synchronizing Translation of Other Target Languages" on page 78.
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6 Reviewing Translated Content

After your translation providers translate your content, the Connector automatically delivers it back into
Sitecore. Each translation is available in the correct language version for each item. When the translated content
returns from translation, its workflow state is Reviewing Translated Version.

To view translated content:

1. Navigate to the content item whose translation you want to view.

2. In the Sitecore Content Editor ribbon, click the Review tab.

3. Inthetop-right corner of the Content tab, click the flag icon representing the default source language.

The Language list opens, displaying all the available target languages. Under each language is the number of
available versions for each language.

e 1-
E English : English L - |
1 version. Englizh

:_= Danish : dansk s
1 version

Dutch (Netherlands) : Nederlands (Nederland)
0 wersions.

5 German (Germany) : Deutsch (Deutschland)
1 version.

Spanish (Spain) : espaiiol (Espania)

1 VErsion.

B W Freach (France) : francaic (France)
o Ml v

&

n More Languages

4. Select the desired target language from the list to view the translation. By default, the latest version of the
translation is displayed.

5. Optional. To view a different version of the translation, click the version icon, to the right of the flag icon, and

select the desired version to view.
/ W -;:-(:-;-,

2. Modfied 11/6/2013 2:51 PM by sitecore\jennifer. arsion? of 2

1. modfied 3/4/2009 %:32 AM by sitecore \admin,

MWJ\JW

| Add Version

The translation of the content item is displayed.
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6. Scrolldown to review the translated content.

7. Inthe Workflow section of the Review tab, either approve or reject the translation:

Analyze Publizh Ver@ons Configure Frecentation Senrity Viewi CT3 Transdabion My Toolbar

Click Edit to lock and edit ths (t2m, | st ) Publsh®

# To approve the translation, click the Publish button. Its workflow state immediately changes to Done.
The translated content may be immediately available for publishing, depending on your workflow
configuration and whether the Done state is configured as publishable.

# To reject the translation, click the Reject button. The workflow state changes to Reviewing, and the
translation status remains Completed.
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7 Post-Translation Features

After the translation is complete, approved, and published, you can perform the following additional optional
tasks:

Task Description Details
synchronize If a content item has been translated into multiple target languages, and you page
translation updated only one target language, you can use this feature to update 78

additional target languages.

request a If you find a mistake in the translated content, you can send a request to the page
translation translation provider to correct the translation and resend it. 81
correction

update a You can update a remote TM (translation memory) server with the latest page
remote TM changes from the TM used by the translation provider. 84
server

clear the You can clear the translation backup database. This database supports the page
translation following features: Translation Correction, Update Remote TM, and 87

backup data SyncTranslation.

7.1 Synchronizing Translation of Other Target Languages

After a content item is translated, you can update translated versions in other target languages with changes in
the source language. This synchronizes translations of a content item in multiple target languages. This is useful
if you changed the content in the source language, and updated the translation in one target language.
However, now, you want to update the content in the other target languages. You can specify at the field level
which field types and target languages you want to update for the new content.

To synchronize the translations of a content item:
1. Navigate to the content item whose translations you want to synchronize and select it.
2. On the Sitecore Content Editor ribbon, click the CT3 Translation tab.

3. Inthe Translation Tools section, click tem Translation Details.

o Haome Mavigale Rewview Analyre Pubslishy Vier o Eunﬂg.l'e Prassn tation Security Ve LT3 Translstion

H ) Bulk Translation ] Transiation Queue g J Clear backup data 1_"*3-.-;
save || ) Translaton Fiter -] Transiation Status %] ltem Trandation Detais 3} Sending: 0
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The Translation Status tab for the content item opens.

J R T3 Translation
Sobet CTTiogFien 31 I
Seard @, »|[ Content Y [#] Transiation Status  x
= [ sitecore aﬁﬁdl

= & content Ttem Source  Target Created Translated  Trandation status Lastipdg

& &) Dealer site [2) feantent/Nicam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software  en [V:1] de-DE,esES, 5 R, itITja-JP AFLesPA  6/26/2013 10:06:18 AM 1E8 [In Queue] Wait for approval  6/26/20

a &_"‘3“‘ :] feontent/Micam Products_CTDemaDigital_SLR [Easy_to_use/D40/Resourcas/Software  en [Vi1] da,de-DE,es-ES,fr-FR,fi-Fl,es-PA 5/3/2013 10:30:27AM EA [In Quewe] Wait for approval  5/3/201.

@ G settngs [B) feontant NicamProducts_CTDema Digital_SLR Easy_to_use/D40 Rescurces/Scoftware e [V:1] de.DE,es-ES,esPA §/17/2013 12:08:46 P4 T [In Queue] Wait for approval /1720

. g':":h:“‘ Ttem [2) feantent Nicam Products_CTheme/Digital_SLR/Easy_to_use/D40/Resources/Software  en [v:1]  de-OE,es-ES,ir FR, fi-F1 esPA 228013 25502PM A [In Queuse] Wit for approval  2/26/20

S @ Products_CTDemo [2) feantent/icam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software  en [v:1] de-DE,esES, R 01T ja-JP AFLesPA  2/27/2013 24@:54PM T [In Quewe] Viait for aporoval  2/27/20

=% Dgxal-sm [2) feantent/Nicam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Rescurces/Software  en [vi1] frFR.ja-FP Bf16/2013 :51:11FM T [In Quewe] Wait for aporoval  8/16/20

© W Ful festured [2) feantent icam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software  en [Vi1]  da,de-DE,es-ES,fr-FR,5-FL,es-PA 8/12/2013 11:47:44 A TEN [In Quewe] Wait for approval  8/12/20

= P Easy o use [) feantent/Nicam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Rescurces/Software e [V:1] esES,f-FR,zhCN,itIT ja-JP 8/12/2013 10:28:20PM  TEN [In Queue] Wait for approval  8/12/20

® M@0 [2) feantent Nicam Products_CTDems/Digital_SLR/Easy_to_use/D40/Resources/Saftware en [V:1] de-DE,es-ES,esPA 4222013 610:03AM T [In Queue] Wait for approval  4/22/20

= f@ow [2) feontent/Nicam Products_CThema/Digital_SLR Easy_to_use D40 Resources/Software  en [V:1]  de-DE es-ES,es-PA ot | [In Quewse] Wait for approval 5722720

= M resources [2)] frontent/hicam Products_CTDema/Digial_SLR/Easy_to_use/D40/Resources/Software en [v:1]  de-DF,85-E5,85-PA Bf19/2013 12:17:09 PM T [In Quesss] Wait for approval - 8/19/20

S raq [2) feontent/Micam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Resources/Software  en [v:1] zh-CN 32U LILSEPM T [In Queue] Wiait for aporoval - 3/21/20

o software [2) feantent/Nicam Products_CTDemo/Digital_SLR/Easy_to_use/D40/Rescurces/Software  en [v:1] de-DE,esES 5f6/2013 473544 T [In Quewe] Wait for aporoval  5/6/201.

[0 Amazing Imagery [2) feantent/Nicam Products_CTDemo/Digital_SLR,Easy_to_use/D40/Resources/Software  en [v:1]  es-E5,K-FR,6FLesPA 6/27/2013 1:51:10PM  EEA [In Quewe] Wait for approval  6/27/20

@ My _Micam @ feantent/Nicam Products_CThema Digital_SLA Easy_to_use/D40Rescurces/Software  en [vi1] 61 [Vi1) R Completed 4f11/20

B g Community & fantentNicam Procucts_CTDemaDigital_SLR Easy_to_use/D40 Resources/Software  en [Vi1] ja-JP [Vi1] N Completed 4f11/20

# @ex & foontent Nicam Procucts_CThemaDigital_SLR Easy_to_use/D40 Resources/Software  en [V:1] esPA [V:1] N Completed 4/11/20

& i support & fontent/Nicam Procucts_CTDemaDigital_SLR Easy_to_use/D40/Resources/Software  en [v:1] itIT [v:2) PN Completed af11/20

@ g Articles & feontentNicam Products_CTDemo/Digital_SLR Easy_to_use/D40/Resources Saftware  en V1] es£5 [v:9] P Completed 4/11/20

# i@ company & feontent/Nicam Products_CThemo/Digital_SLR Ezsy_to_use/D40/Resources/Software  en [vi1]  frFR [Vi6] 4/11/2013 10:25:56 AM (PN Completed 4/11/20

& () Giobals @ fcontent/Micam Products_CTDema, Digital_SLA Easy_to_use/040Resources/Software  en[Vi1] #FR [v:7] B/30/2013 2:48:56 M PGP Completed a/30/20

& ()RS5 Feeds il = ] Il

. 5 (1D Calumcar Everts , || TotaTransiations: 21 =

This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Iltem" on page 72.

4, Select an item that has already been translated. This item has Completed status.

5. Right-click, and select Synchronize Translated Versions from the context menu.

The Welcome page of the Synchronize Translation wizard opens.

6. Click Next.

The main page of the wizard opens.
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E | (=1 =] e
sitecore/shell/defaultaspx?xmlcontrol=CT3_SyncTranslation® 'F |
CT3 Synchronize Translation
Detect source content changes (per field), and send changed content for translation so all languages are E
synchronized.

You have changed the following source content fiskds and they require translation synchronization
_ D=play name
Effectve Pixels
| M e
Type of Camera
[ Tite
Image Sie pixels
Frice
| Sensitivity
File Svstem
Target languages that require translabon synchronization (Mo new Version will be reated)

[¥] German (Germany) : Deutsch (Dewtschiand)

[] sparish (Spain) : espafiol (Espaiia)

|| French (France) : frangais (France)

| Chimese (People's Republc of China) : (£ . ES0E)

7. The first section displays a list of all field types in the content item that were updated, and that should be
synchronized in the translated items.

# Select the check boxes for the field types for which you want to synchronize the translation.

If there are field types for which you do not want to synchronize the translation, leave the check boxes
cleared. The translations for fields of those field types will not be updated.

8. The second section displays the target languages that require translation synchronization.
Keep the check boxes selected for the target languages you want to synchronize.

If there are target languages you do not want to synchronize, clear the check boxes cleared. The
translations for these languages will not be updated.

9. Click Send.

The Connector sends the changes in the selected field types for translation in the specified languages.

Note: The Connector does not create a new version for the synchronized translations.
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The summary page of the wizard opens.

sitecore/shell/default.aspx?xmlcontr

CT3 Synchronize Translation wizard has completed.
Click Finish to close the wizard.

Sent out a Synchronize Translation asset:

S5ent changed field content from the following fields

Custom Settings
Operating Environment

To enaure the content of fallowing languages i3

It displays the fields that the Connector sends for translation, and the target languages that will be
synchronized.

10. Click Finish.

The wizard closes.

7.2 Requesting Translation Correction

If you find a mistake in the translated content, you can send a request to the translation provider to correct the
translation and resend it.

1. Inthe Sitecore Content Editor, navigate to the content item for which you want to request a translation
correction.
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2. Inthe Sitecore Content Editor ribbon, click the CT3 Translation tab.

3. Inthe Translation Tools section, click Item Translation Details.
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This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Iltem" on page 72.

4. Select an item that has already been translated. This item has Completed status.

5. Right-click, and select Request Translation Correction from the context menu.
The Welcome page of the Translation Correction wizard opens.

6. Click Next.

The main page of the wizard opens.
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7 Sitecore - Google Chrome

CT3 Translation Correction

Source Language: English : English
Target Language: German (Germany ) : Deutsch {Deutschland)
[Felds requiring translation correctons

[ _pisplay name

[ Effective Picels

|7 Menu et

[¥#] Type of Camera

[¥] Tite

[ Image Size pixels

[ rics

[ sensitrity

[ File System

[¥] Shart Descriptian

MNotes:
Flease update...

ask your translation Provider to revise the translation in the falowing fields.

[ fsitecore/shell/default.aspx?xmlcontral=CT3_T -1~'f.'m'-'r-f—irF

£

| =Back ||

7.2 Requesting Translation Correction

7. Thefirst section displays a list of all field types in the content item. Select the check boxes for the field types

for which you want to request a correction.

8. Inthe second section, Notes, enter your correction request for the translation provider.

9. Click Send.

The Connector sends the selected field types in the content item and your notes to the translation provider

as a correction request.

The summary page of the wizard opens.

Clay Tablet Translation Connector for Sitecore User Guide

Version 3.6.2

Page 83
February 25, 2014



7 Post-Translation Features 7.3 Updating a Remote TM Server

- Stecore - Google Chrome

sitecore/shell/default.aspx?xmlcontrol=CT

The CT32 Translation Correction wizard has
completed. Click Finish to close the wizard.

Sent out a NeedTranslabonComrecton asset:

Translation Language Pair: en ==3> de-DE

Content requiring translation corrections
from fields:

Type of Camera

Titcle

Short Descriprtion

It displays the translation language pair and the field types for which you requested a translation correction.
10. Click Finish.

The wizard closes.

7.3 Updating a Remote TM Server

After you receive translated content back from your translation provider, you can update a remote TM
(translation memory) server with the latest changes from the translation provider's TM.

Your changes will be copied to the UpdateTM folder that resides on your translation provider's FTP server.

Note: This feature is available only with the Clay Tablet FTP Connector. The location of the remote TM server is
specified by the TNS UpdateTMFolder setting in the FTP configuration file, which is configured by CTT.
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1. Inthe Sitecore Content Editor, navigate to the content item for which you want to send updated translation
content to a remote TM.

2. Inthe Sitecore Content Editor ribbon, click the CT3 Translation tab.

3. In the Translation Tools section, click Item Translation Details.
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This tab displays translation-status information about the selected content item and any child items. For a
detailed description of this tab, see "Monitoring Status for a Single Item" on page 72.

4. Select an item that has already been translated. This item has Completed status.

5. Right-click, and select Send Post-Edited Content to Update a Remote TM from the context menu.
The Welcome page of the Translation Memory Update wizard opens.

6. Click Next.

The Update a Remote Translation Memory Server page of the wizard opens.
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7.3 Updating a Remote TM Server

G CELE
[ ‘sitecore/shell/defaultaspx?xmlcontrol=CT3_Update TM& i?vnF

Update a Remobe Translation Memory Server

Source Language: English : English
Target Language: Spanish (Spain) : espaniol (Espania)

Send updated field content from this item 1o a remote TMS to update its Translaban Memory.

— Select fields with post-edited content to update a remate TM
[] __Display name
[] Effective Pixels
[7] mery titke
|7 Tvpe of Camera
[ Titte
[] Image Size pixels
[ price
[] sensitvity
[7] File System
[] shart Description
[] Storage Media
["] Deseription
[ intesface

() [ I

7. Thesource and target languages are displayed. The main section displays a list of all field types in the
content item. Select the check boxes for the field types that you want to send to the remote TM server.

8. Click Send.

The Connector sends the content from the selected field types in the content to the remote TM server.

The summary page of the wizard opens.
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sitecore/shell/default.aspx?xmlcontr

The CT3 UpdateTM wizard has completed. Click
Finish to close the wizard.

Sent out an UpdateTH asset:

TH Language Pair: en == &3-E5

FPosct-edited content from fields:
Title

File System

Jhort Description

Storage Media

It displays the translation language pair and the field types for which the Connector sends content to the
remote TM server.

9. Click Finish.

The wizard closes.

7.4 Clearing Backup Data

You can delete all the backup data used by the following Connector translation features: Translation Correction,

Update Remote TM, and SyncTranslation. You can delete the backup data from either the Sitecore Content
Editor or the Sitecore Desktop.

1. Do one of the following to open the Translation Data Cleanup wizard:

@ In the Sitecore Content Editor ribbon, click the CT3 Translation tab, and then in the Translation Tools
section, click Clear Backup Data.
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AT .

) Transiation Status

In the Sitecore Desktop, click the Sitecore menu, and then select All Applications > CT3 Translation >
Clear Backup Data from the menu.

The Welcome page of the Translation Data Cleanup wizard opens.
2. Click Next.

The Delete CT3 Translation Backup Data page of the wizard opens.
I ¥ Sitecore - Google Chrome -
| Bl sitecore/shell/default.aspx?xmicontrol=CT3_ClearBackup

Delete CT3 Translation Backup Data
Delete all badwp data used by the CT3 translaton features.

The "Clear Backup Data” feature will free some database and hard drive space, but several useful features, ke Update
remote TM', Translation Correction’ and *Synchronize Translaton”, require this data and WILL MO LOMGER WORK for all
previous translation projects if you delate it

Delete badwp data
[¥] Backup transiation projects
[¥] Backup item transiatons

mTrnmiuﬁm Logs

[ <Back || Clear> | | canca

3. Select the types of backup data to delete:

Backup translation projects: Metadata about translation projects, and which content items and versions
are in which projects.

Backup item translations: Individual content item translations at the field level.
# Translation logs: Log files of all the events that occurred in a translation project.
4, Click Clear.

A warning message box opens.
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The page at | says: "

Are you REALLY sure?
Erasing this data will make several features unusable for all
projects previous to the date of dats erasure,

Only proceed if you (and all other translstion stakeholders)
are confident this is what you want to do.

0K Cancel

5. Ifyou are sure you want to delete the backup data, click OK.

The summary page of the wizard opens, displaying the number of each type of backup file you deleted.
| 7 Sitecore - Google Chrome

sitecore/shell/default.aspx?xmicontrol=CT

The CT3 Translation Data Cleanup Wizard has
completed. Click Finish to close the wizard.

A total of 10 translation log files have been
delecead.

6. Click Finish to close the wizard.
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